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Before you begin

7is learner guide is based on the unit of competency BSBITU212 Create and use 
spreadsheets, Release 1. Your trainer or training organisation must give you information 
about this unit of competency as part of your training program. You can access the unit of 
competency and assessment requirements at: www.training.gov.au.

How to work through this learner guide
7is learner guide contains a number of features that will assist you in your learning. Your 
trainer will advise which parts of the learner guide you need to read, and which practice 
tasks and learning checkpoints you need to complete. 7e features of this learner guide are 
detailed in the following table.

Icon Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across 

content that is confusing, make a note and discuss it with 

your trainer. Your trainer is in the best position to offer 

assistance. It is very important that you take on some of 

the responsibility for the learning you will undertake.

Examples These highlight learning points and provide realistic 

examples of workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills 

and knowledge into action. Your trainer will tell you which 

practice tasks to complete.

Video clips Where QR codes appear, you can use a smartphone or 

other device to access video clips relating to the content. 

For information about how to download a QR reader app or 

accessing video on your device, please visit our website: 

www.aspirelr.com.au/help

Summaries Key learning points are provided at the end of each topic.

Learning 

checkpoints

There is a learning checkpoint at the end of each topic. Your 

trainer will tell you which learning checkpoints to complete. 

These checkpoints give you an opportunity to check your 

progress and apply the skills and knowledge you have 

learnt.
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Foundation skills
As you complete learning using this guide, you will be developing the foundation skills 
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 
skills and the employability skills required for participation in modern workplaces and 
contemporary life.

7e following table outlines speci)c foundation skills noted for your learning in this 
learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises numerical and textual information within a range 

of resources to determine and complete work according to 

requirements

Writing  • Enters and amends routine data into relevant digital applications 

using a format appropriate to requirements

Oral communication  • Listens to short and speci�c instructions and uses questions to 

clarify understanding

 • Uses simple mathematical language to con�rm and convey 

requirements

Navigate the world of work  • Recognises and follows explicit and implicit protocols and meets 

expectations associated with own role

Interact with others  • Recognises purpose of various communications directly relevant 

to own role and clari�es as required

Get the work done  • Uses key digital application features and functions in performing 

speci�c work tasks
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Organisations use spreadsheets to store and calculate numerical data, such as 

�nancial statements and product pricing information. 

When you are required to enter data into a spreadsheet for your organisation, you must )rst 
identify what kind of data it is and a suitable way to enter it. For example, a report mainly 
containing text would be correctly entered using a word-processing application, but data 
that has a lot of numbers should probably be entered into a spreadsheet. Once you have 
entered data, you will need to format it to suit your organisation’s style and presentation 
requirements. A spreadsheet is easier to read when it has been formatted properly. 

In this topic you will learn how to:

1A Use safe and e�cient work practices

1B Identify and clarify spreadsheet task requirements
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Workplace safety is everyone’s responsibility. 

Both employers and employees must make an active 
contribution to ensuring their workplace is safe. 
Hazards need to be identi)ed and risks assessed to 
reduce the risk of injury in the workplace. If you are 
working at a computer for an extended period of time 
each day, your workstation must be comfortable and 
designed to help you carry out your tasks e�ciently. 
You will need to organise your work so that you are 
not doing a repetitive task for a long time. You should 
also take regular breaks to stand up and stretch. 

Another consideration is to use resource 
conservation techniques to prevent wastage. Most 
organisations require staD to follow resource-saving 
procedures such as turning oD lights in unused rooms and recycling paper. You need to be 
aware of any conservation eDorts made by your organisation.

Health and safety legislative requirements

You must work in line with legislative requirements, regulations, Australian and 

industry standards, and the relevant codes of practice.

All health and safety legislation requires employers to provide a safe workplace and 
adequate training and supervision, while controlling workplace hazards and risks. 

Health and safety regulations support the legislation by outlining speci)c health and safety 
requirements that must be addressed.

7e Model Work Health and Safety (WHS) Regulations provide a framework that has been 
adopted by all Australian states and territories except for Victoria and Western Australia, 
which have their own legislation and regulations. 

Health and safety legislation outlines legal requirements such as:

 • managing risks to health and safety

 • promoting and maintaining the health, safety and welfare of people at work

 • protecting people at work from injury and illness, including psychological injury

 • protecting the health and safety of the public in workplaces

 • consulting workers and encouraging them to maintain health and safety

 • providing rehabilitation and maximum recovery for injured workers.

1A Use safe and e,cient work practices
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Health and safety policies and procedures

Health and safety policies and procedures are documents that ensure all 

employees work safely and e"ectively. 

All workplaces in Australia are required to have a policy in place that describes the 
organisation’s and employees’ responsibility for maintaining health and safety. 7e policy 
should include the organisation’s goals and objectives regarding health and safety, and can 
help you ful)l your duty of care as an employee.

7e following information relates to working in an o�ce and using a computer workstation, 
and should be contained in an organisation’s health and safety procedures.

Health and safety procedures outline:

 • workstation ergonomics

 • standard safety precautions and housekeeping

 • safe handling of hazardous substances, e.g. cleaning products

 • emergency and �re drills

 • hazard identi�cation and risk control

 • manual handling

 • emergency contact numbers, including local doctors and hospitals

 • location of �rst-aid equipment 

 • details of �rst-aid of�cers.

Control risks associated with hazardous manual tasks

It is a legal requirement for the PCBU and workers to address the risks 

associated with hazardous manual tasks in the workplace. 

7e WHS Regulations and the Code of Practice for Hazardous Manual Tasks outline 
speci)c requirements for hazardous manual tasks that must be addressed. 

A person conducting a business or undertaking (PCBU) must manage risks to health and 
safety associated with undertaking a hazardous manual task, including risks of developing a 
musculoskeletal disorder (MSD).

7e Hazardous Manual Tasks Code of Practice helps PCBUs and workers to:

• identify hazardous manual tasks

• assess the risks

• control the risks

• review the control measures.

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own 
set of procedures to manage the risk of MSDs.
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To determine which control measures to implement, the PCBU must consider the 

following:

 • postures, movements, forces and vibration relating to the hazardous manual task

 • the duration and frequency of the hazardous manual task

 • work conditions that may affect the hazardous manual task or the worker

 • the design of the work area and layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of people, animals or things involved in carrying 

out the hazardous manual task.

Musculoskeletal disorders 

The repetitive movements and sustained body position associated with 

entering data into a computer is regarded as a hazardous manual task and puts 

the operator at risk of developing an MSD. 

MSDs come about in two main ways:

• gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through 
repeated or continuous use of the same body parts, including static body positions

• sudden damage caused by strenuous activity or unexpected movements, such as when 
loads being handled move or change position suddenly.

MSDs may include conditions such as: 

 • sprains and strains of muscles, ligaments and tendons

 • back injuries, including damage to the muscles, tendons, ligaments, spinal discs, 

nerves, joints and bones

 • joint and bone injuries or degeneration, including injuries to the shoulders, elbows, 

wrists, hips, knees, ankles, hands and feet

 • nerve injuries or compression, e.g. carpal tunnel syndrome

 • muscular and vascular disorders as a result of hand–arm vibration

 • soft tissue hernias

 • chronic pain.

Standard precautions

Your organisation may require you to use standard precautions, particularly 

work practices related to the prevention of repetitive strain injuries (RSIs). 

7ese include ergonomic practices, workstation design, enforced breaks and regular exercise 
routines. A workstation includes a computer, monitor, keyboard, mouse, desk and chair.

Workers in an o�ce are expected to follow standard precautions when using a workstation, 
particularly at a sit-down desk. Research on sitting has demonstrated that other precautions 
also need to be considered, such as the use of standing workstations, to ensure that injuries 
are prevented. It is important that you carefully follow any standard precautions that are 
prescribed for your workplace.
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Equipment and systems safety checks

An important part of your daily work routine is to check the various systems 

and equipment you use during the day to make sure they are in good working 

order. 

Your organisational policies and procedures should include steps to follow. You may need 
to perform this procedure at the start of your work day or at speci)ed intervals throughout 
the day.

Workstation safety procedure/checklist:

 • Ensure your seat is positioned in front of your computer and that you can reach your 

keyboard comfortably.

 • Position the monitor out of direct sunlight and at the correct height. 

 • Ensure the environment is dust-free as dust can affect the monitor or the computer’s 

central processing unit (CPU).

 • Ensure cables are secured so no one trips over them.

 • Use blinds and window coverings to reduce glare and heat at your workstation.

 • Ensure temperatures do not exceed 26°C and that humidity is 40–60 per cent.

Ergonomics

The aim of ergonomics is to reduce the risk of accidents, injury and illness by 

applying safe work practices. 

Ergonomics is about creating comfortable 
working conditions by adapting 
workstations, tools and equipment to 
an individual worker’s needs. It also 
improves performance and productivity 
in the workplace. Ergonomics covers all 
aspects of working, from physical stresses 
such as sitting at a workstation all day to 
environmental factors such as noise, air 
conditioning and lighting.

When your posture is poor, you may suDer from aches and pains. Spending a long time in 
the same position can put stress on your body and this can be made worse if you are in an 
uncomfortable or poorly supported position. 7ese symptoms may be very slight at )rst, but 
if you continue to have poor posture your symptoms may get worse and become intolerable. 
7ey may result in cumulative stress given the constant strain on your muscles, nerves or 
tendons. 

When setting up your workstation, make sure your posture will not cause you pain or 
discomfort. 7e equipment you use needs to be adjusted to suit your body shape and size, 
and the tasks you are doing.
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Ergonomic workstation design

How your workstation is designed can a"ect your health and wellbeing. 

Several physical problems can result from poor workstation design; for example, lower back 
strain may result from sitting in a chair that does not support your back. Some features of 
the workstation may vary depending on the type of computer work being performed. 

Below are some guidelines for setting up an ergonomic workstation. 

Chair

Adjust the seat height to suit your furniture and equipment. Ensure 

that your feet are  at on the  oor, your thighs are horizontal and 

your lower legs are vertical. If possible, use a chair with a �ve-

castor base.

Adjust the backrest by raising it to the maximum height and then 

lowering it until it �ts the curve of your lower back. If this is not 

comfortable, lower it another couple of centimetres. Continue this 

until it reaches a comfortable position. 

The backrest should support your lower back, and may also be 

adjusted backwards and forwards. When seated in your usual 

working position, move the backrest until it has a gentle pressure 

on your lower back. Make sure there is at least two centimetres of 

space between the front of the seat and the back of your knees. 

Armrests should be positioned so that they do not interfere with 

carrying out your work tasks.

Desk

Keep your head erect when seated at your desk, and ensure that 

the surface of the desk is just below elbow height. 

If your desk is not height-adjustable, try to raise your chair so you 

are sitting at the correct height, and use a footrest, if necessary, 

to make up the difference. Ensure there is clearance between the 

lower edge of the desk and your legs, and between the front edge 

of your seat and your desk.

If your desk is too low, you may be able to extend the legs. You 

should have plenty of leg space underneath your desk. Don’t 

clutter the space with bags and bins, as your legs may become 

cramped and your posture may become twisted. 

Position any equipment or materials you use so that you can reach 

them easily without twisting. For example, place frequently used 

stationery in the top desk drawer, and ensure your keyboard and 

monitor sit directly in front of you to avoid having to twist your body.
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Keyboard

The angle of your keyboard can be adjusted to suit you by moving 

the supports underneath it. Place the keyboard as close as 

possible to the front of your desk. Have your upper arms hanging 

freely. Your forearms should be approximately horizontal.

While typing it is best not to rest your wrists, as they should not 

be bent up, down or to the side. The knuckle, wrist and top of the 

forearm should form a straight line. Wrist supports give you a place 

to rest your hands only when pausing from typing, not while you 

are typing. Do not pound the keys; instead, use a light touch. Leave 

enough room on your desk to put the keyboard out of the way when 

you are not using it.

Don’t place documents between yourself and the keyboard, 

as stretching will eventually cause muscle strain in your arms, 

shoulders and neck. 

Mouse

Place the mouse and mouse pad directly beside your keyboard on 

the side you prefer. If you use the mouse frequently, you could try 

to alternate sides. You will be surprised at how easy this becomes 

with practice. Your wrist should be straight and the desk should 

support the weight of your wrist, not your arm. Try to keep your 

wrist  at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not 

using it.

Monitor

Once you have adjusted your chair and desk, you can position 

your monitor. Adjust it so that the top of the monitor is level with or 

slightly lower than your eyes. If you can’t adjust the monitor to the 

correct height, place it on a platform.

The viewing distance should be between 40cm and 70cm. The 

screen angle should be adjustable between 85 and 125 degrees. 

It is best to position the screen so that you can clearly read the text 

without having to lean forward, twist your neck or look upwards. 

A relaxed viewing angle is approximately 35 degrees. Place a 

document holder beneath or beside the monitor at the same 

viewing distance as the screen.

Also take surrounding factors into consideration, such as re ection, 

glare and shadow, when positioning your screen. You may also 

need to use an anti-glare �lter.
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Desktop layout

Items on your desk, including equipment and resources, should be arranged so 

they are within easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate most of 
the time

• the maximum reach zone – items are further away, but still close enough to reach 
comfortably

• the outer reach zone – where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard, are 
close to you. Objects that are used less frequently, such as your phone, should be out of the 
way but still within easy reach. Other resources that are rarely used, such as in- and out-
trays, should be in the outer reach zone.

7e following outlines some devices that can help you maintain a good posture at your 
workstation.

A footrest 

may be 

necessary 

if you can’t 

place your 

feet comfortably 

on the  oor. 

Footrests allow 

your feet to rest at the 

correct height and on a 

tilting angle, which prevents strain on 

the lower back.

If you use a 

telephone 

for long 

periods of 

time, it is a 

good idea to 

use a headset. 

A headset will keep 

your neck straight and 

your arms free. Headsets 

prevent you from bending your neck 

to support the telephone handpiece.

Angle boards allow the user to maintain 

the correct posture when reading by 

reducing the angle between the work 

surface and the user. These supports 

can be adjusted to a suitable height and 

angle, and enable comfortable reading 

with the neck correctly positioned. Try to 

keep your neck as straight as possible 

when you are reading.

Document holders are designed to 

hold papers and reference material in 

a convenient position for viewing. Place 

your document holder in the correct 

position. If it is below the screen or too 

far off to the side, each time your eyes 

look from one source to the other, your 

pupils have to adjust. Doing this for long 

periods of time can cause headaches 

and eyestrain. Place the 

document holder at a 

similar level, angle 

and distance as 

the screen to 

avoid having 

to shift your 

eye focus. D
oc

um
en

t 

hol
der

s

Fo
ot

re
st

s

Angle boards

H
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Setting up a home o,ce

Communication technology and organisational policies to maintain a 

sustainable work–life balance have created opportunities for more 2exible 

working arrangements. 

7is means that more employees are working from home o�ces or in other remote o�ce 
locations. Many bene)ts can be derived from Jexible working arrangements for employers 
and employees, but there is still a responsibility for all parties to make sure that home and 
remote o�ces use ergonomic practices and follow health and safety requirements.

Hot desking

Hot desking refers to a system where workstations are not assigned to an 

individual worker, but may be used by multiple workers during di"erent periods 

of time. 

7e motivation behind hot desking is primarily the cost savings achieved by setting up 
fewer workstations when not all the workers are in the o�ce at the same time. 

Another common adaptation of hot desking is where workstations are assigned to 
individual workers, but need to be readily available for other workers to access based on 
daily work requirements, such as a group of people coming together to work on a speci)c 
project.

Considerations with hot desking:

 • It is common for workers to want their own space. Consequently, they may choose 

one location and stick to it.

 • It can take extra time each day to set up a workstation for each individual to 

maintain good ergonomics and work ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on items 

such as keyboards and mouses.

 • Workstations need to be tidied appropriately in readiness for the next user. 

Bene1ts of using standing desks

Sitting at a desk for long periods of time has 

many negative health e"ects. 

7ese can be overcome by using standing desks. 
Standing provides a greater opportunity for your 
body to move and adjust, and involves more 
muscular activity than sitting. 

Some studies have shown that the negative eDects of 
prolonged sitting cannot be counteracted by regular 
exercise. 7e only way to eliminate the problem is to 
avoid sitting as much as possible. 
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Some of the health bene)ts of standing include:

• alleviating back pain and other repetitive strain injuries by greater use of core back 
muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood clots, which 
can be caused by prolonged sitting.

It is recommended that you start using a standing desk gradually by alternating between 
sitting and standing. Using a standing desk for hours on end requires your body to adapt. 
You may experience sore feet, tired legs and fatigue at )rst. Wear comfortable shoes and use 
an anti-fatigue Joor mat to help counteract this.

Ensure you have an ergonomically designed standing desk so that you maintain correct 
posture while working. 

Standing desk recommendations:

 • Position arms at 90 degrees when standing.

 • Place the computer screen at eye level and tilt it slightly upwards.

 • Place the computer monitor at least arm’s length away.

 • Keep your back straight and avoid leaning on the desk.

Monitor and adjust lighting

Good lighting is essential for a safe and hazard-free workplace. 

You need to see things clearly in order to work eDectively. Simply shi&ing the screen angle, 
adjusting blinds, altering the brightness settings on the screen and using desk lamps can 
reduce risks associated with poor lighting. Try to use natural sunlight rather than arti)cial 
lights if possible. If not, keep bulbs and )xtures clean, focus light on your task and use 
Juorescent lights to minimise eye strain and headaches.

The following are hazards associated with poor lighting:

 • Glare – A computer screen positioned in front of a bright window can be dif�cult to 

see.

 • Flickering lights – A  uorescent light may malfunction, causing annoyance, irritation 

and even nausea.

 • Inadequate lighting – Reading in dim light can cause eyestrain.

 • Shadows – Shadows shifting across your work area can cause you to sit with bad 

posture in order to view your work.

Manage noise in the workplace

Noise can include any ongoing, loud or disturbing sound. 

Excessive noise around machinery or equipment can cause permanent hearing loss. 
Noise is a problem if it disturbs or distracts employees, causes stress or interferes with 
communication or work.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

11

Topic 1
Select and prepare resources

Many o�ces are open-plan, o&en with employees seated close to each other and divided 
by partitions at chest or head height. 7ink about noise levels when you set up your 
workstation. It should be possible for people in open-plan o�ces to have some privacy when 
they are on the phone and carrying out their day-to-day tasks.

Noise in the o�ce can come from:

• machines and equipment, such as photocopiers, fax machines, phones and printers

• outside tra�c and road works

• people talking to each other or on the phone.

Noise can also be a problem in other workplaces, such as on factory Joors and at 
construction sites. You may have to wear ear protection if you are required to work in an 
excessively noisy environment.

7ere are many ways that noise can be controlled in the workplace. Examples include: 

• Noisy machines can be put in a separate room or area. 

• Sound-absorbent materials such as carpet and partitions can be installed or arranged to 
deJect and absorb noise. 

• 7e volume level on your speakers can be adjusted.

Remember that noise is only a hazard when it is stopping you from working productively, 
comfortably or safely. Many people prefer to work with low levels of noise rather than 
complete silence.

Monitor and adjust air conditioners

Air-conditioning systems may cause hazards due to poor-quality air or 

inadequate temperatures.

Air-conditioned o�ces o&en do not have enough fresh air from open windows. 7is can 
cause problems for some people. 7e air quality may need to be adjusted by allowing more 
fresh air inside or by improving the ventilation system.

Additionally, o�ce workers frequently complain of being too hot or too cold. If a person’s 
desk is near an air-conditioning outlet, the area around their desk can be much colder than 
elsewhere in the o�ce. 7ey can also suDer from dry and itchy eyes. Report such hazards 
to the relevant person. 7is situation can usually be corrected by adjusting air-conditioner 
settings.

Vary your activities

Make sure you plan your daily tasks so that you aren’t doing repetitive work for 

long periods of time.

Having a well-planned workstation and comfortable surroundings is pointless if you don’t 
organise your work in a way that prevents discomfort or pain. 

Your work role may involve several diDerent tasks. Some tasks may be repetitive, such as 
typing up reports or entering data. If you are able to vary the tasks you carry out each day, 
this will help to prevent repetitive actions that cause stress to your body. For example, if you 
have to enter a lot of data, break up the repetitive nature of the task by discussing a project 
with a colleague, doing some research online or doing another work task. 

You should also take regular breaks. Employers are required to allow employees to take rest 
periods throughout the day, including tea and lunch breaks, to reduce stress and fatigue.
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Take exercise breaks

Using computers for too long without breaks has been associated with back 

and neck pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage your colleagues to try 
them too. Make sure you are relaxed and stretch gently, without overstretching. Stop if 
you feel any pain or discomfort, and remember to exercise both sides of your body. Most 
importantly, breathe deeply and evenly throughout the stretch.

 • Neck: Turn your head gently to look over your right shoulder. Hold for 10 

seconds. Now roll your head forward to look over your left shoulder and hold 

for 10 seconds. Repeat several times.

 • Shoulders: Sitting with a straight back and neck, roll your shoulders forward, 

then back. Repeat several times.

 • Wrists, hands and arms: Interlacing �ngers, turn your palms upwards. Now lift 

your arms over your head and stretch, leaning gently to the left and then to the 

right. Repeat movement several times.

 • Upper and lower back: In a standing position, place your hands in the small 

of your back. Gently arch your back and hold for 10 seconds. Repeat when 

needed.

 • Shoulders and arms: Stretch your arms above your head, cradle your elbow 

with your hand and gently pull your elbow behind your head. Repeat on the 

other side, holding the stretch for 10 seconds.

 • Eyes: Every 20 minutes, look away from the screen. Focus on a distant object 

(more than three metres away).

Watch a video demonstration of the above 

exercises here.
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Practise conservation techniques

Conserving resources at work not only bene�ts the organisation by reducing 

costs, but also the planet by reducing greenhouse gases and the amount of 

waste sent to land�ll. 

Most organisations have policies and procedures for conserving resources. You can )nd out 
what these are by reading your workplace manual, or by asking your manager or colleagues.

7e following outlines ways to conserve resources at work.

Minimise paper wastage

Policies for reducing paper wastage include:

 • using both sides of the paper when printing and photocopying

 • recycling non-con�dential waste paper 

 • reducing the volume of printing where possible

 • reusing paper by using blank sides for rough drafts 

 • using recycled paper or paper from plantation timber for printed documents.

Reduce energy use

Policies and procedures for saving energy include:

 • providing training programs on smart energy practices so that employees can 

practise energy ef�ciency

 • turning off lights and equipment when not in use

 • keeping air conditioners at 18–20°C in winter and 24–27°C in summer

 • using power-saving functions on devices such as computers and tablets.
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Practice task 1

Question 1 

Here is a checklist to follow when setting up your workstation. Go through the points that are 

relevant to you and make any necessary adjustments to your work area. You may need another 

person to help you and check your posture. If you are not able to tick some of the checkpoints, 

discuss making alterations to your workstation with your manager.

Chair

 � Is the seat height-adjustable?

 � Is it high enough to allow you to sit comfortably at the keyboard?

 � Is it stable?

 � Does it swivel?

 � Is the height of the backrest adjustable and does it tilt backwards and forwards?

 � If it has arms, can you still get close enough to the desk and swivel the chair?

 � Are your feet  at on the  oor or are you using a footrest?

 � Are you sitting up straight with the backrest �rm against your back?

Desk

 � Is it large enough to allow the screen and keyboard to be correctly positioned?

 � Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

 � Is it high enough to allow your thighs to �t comfortably underneath?

Keyboard

 � Can it be tilted to allow you to adjust it?

 � Are the symbols on the keys clear and easy to see?

 � Is there suf�cient space in front of it to allow you to correctly position your arms?

Monitor

 � Does the monitor have easily adjustable brightness and contrast controls?

 � Is the image on the monitor stable and  icker-free?

 � Are there adjustment mechanisms to allow the monitor to be tilted, swivelled or raised to 

avoid glare and re ections, and help you keep a natural and relaxed posture?

 � Are you sitting far away enough from it for comfort?
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Question 2 

Describe the possible consequences for an organisation in which employees do not consider 

their physical health.

Question 3 

What should WHS policies and procedures include?

Question 4 

Why should you vary the tasks you carry out each day?
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Organisations use spreadsheets to perform calculations and record numerical 

data. 

For example, sales )gures and payroll information are usually recorded on spreadsheets. 
Once the data has been entered, calculations can be performed on the numbers to produce a 
required result, such as total monthly takings or a calculation on interest payments.

Many organisations have speci)c requirements in relation to data. You must be aware 
of these requirements so your spreadsheet meets your organisation’s standards. 7ese 
requirements may be in relation to how the data is entered, stored, presented or produced.

Requirements for the task may also be speci)ed by your supervisor or another person 
requesting the information. It is important to follow instructions and clarify requirements. 
Part of clarifying requirements is asking questions. It may also include checking 
information and the presentation of past spreadsheets, as well as showing someone a dra& of 
the spreadsheet prior to completion. You need to know how long you have to complete the 
task because the time line will allow you to organise your time and schedules.

Instructions on organisational and task requirements should be used to check that the job 
has been completed correctly. 

Purpose, audience and presentation requirements 

Most organisations have requirements for the style in which spreadsheets 

should be presented. 

You need to be familiar with the styles used by your organisation. An organisational style guide 

will explain all the specifications and design details. Some organisations use templates to ensure 

the layout and design of a document meets the corporate image of the organisation. 

The following outlines guidelines on what to consider when determining a document’s purpose, 

audience and presentation requirements. Always refer to your organisational style guide for 

instructions on format and final presentation.  

Purpose

The purpose of a spreadsheet varies and will in uence the type of document you 

produce. Clarify the purpose of the spreadsheet before you begin to determine the 

way it is planned and designed. For example, if the document’s purpose is to provide 

numerical data on sales �gures, you may have to collect the information and collate this 

into the spreadsheet.

Audience

You need to be aware of your document’s audience. Keep in mind who it is intended 

for and decide how the information should be presented. The document’s audience 

will affect how the information is presented. Consider the information needs of the 

audience and how detailed the information should be. A detailed document is likely to 

have many columns and rows, or may extend over several sheets. 

1B Identify and clarify spreadsheet 
task requirements
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Presentation requirements

How you present your spreadsheet will enhance the audience’s ability to understand 

it. You need to check if there is a template for the task, such as a template for a 

presentation, handout or report. Think about the use of colour, columns and rows, logos 

and formatting requirements.

Determine and meet time lines

Whenever you are given a work task, you need to determine a time line for its 

completion. 

A time line is a plan for how long a task will take to 
complete. It also breaks the task into steps and details 
when each step needs to be completed by. Using a 
diary system and a to-do list can help you prioritise 
tasks and keep on top of the time lines required for 
set tasks.

In many cases, time lines are set and agreed with 
your stakeholders – both internal and external. 
Internal stakeholders are those that work at the same 
organisation as you, and may include colleagues 
in other departments, managers and supervisors. 
External stakeholders are those that are outside the 
organisation, including customers and suppliers. 

O&en your manager or supervisor will give you a deadline for completing a task, e.g. 
prepare a spreadsheet by 2pm. Alternatively, you may have deadlines for completing regular 
work tasks, e.g. completing a monthly sales report or a summary of customer contact 
details. 

Meeting a deadline demonstrates your competency and professionalism in undertaking 
tasks. Make sure that when deadlines are set, they are both achievable and realistic.

If you have concerns that a deadline might not be met or you have conJicting work 
priorities, discuss this with your manager or supervisor as soon as possible. 7ey may be 
able to assist you by suggesting how the deadline can be met or agreeing to adjust the time 
line for the task.

Select spreadsheet software

All organisations need to manage and store numerical data, and a spreadsheet 

is the most appropriate tool for doing this.

In accounting, a spreadsheet is a large sheet that displays a company’s )nancial position. 
It shows all )nancial information (such as costs, income and taxes) on a single sheet 
for a manager to look at when making a decision. An electronic spreadsheet organises 
information into columns and rows. 7e data can then be manipulated by a formula to 
provide a sum total. 7e spreadsheet can present the information in a format to help a 
decision-maker see the )nancial big picture of an organisation. 
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7e most commonly used spreadsheet so&ware is Microso& Excel, although some 
organisations prefer to use other programs. Some of these applications can be shared and 
worked on by multiple users at once and accessed online. 7is is known as cloud computing.

7e following table outlines some of the key features of each.

Spreadsheet 

software

Key features

Microsoft Excel  • Calculation tools

 • Tools for creating graphs and charts

 • Tools to hide columns, rows and sheets

 • Provides access to external data sources

 • Password protection

 • Able to communicate with other Microsoft Of�ce programs, 

including Word and Access

Google Sheets  • Cloud-based, meaning multiple users are able to work in 

the document at once to collaborate on tasks

 • Available as desktop software, online application and 

mobile app 

 • Keeps track of revision history

 • Uses action items to assign a person to a task

 • The Explore function allows users to search for information 

online

Apache 

OpenOf�ce Calc

 • Able to summarise and convert raw data into meaningful 

information

 • Formulas can be created using both numbers and words, 

e.g. ‘sales – costs’

 • Includes ready-made templates

 • Allows users to forecast results, e.g. based on high or low 

sales results

 • Allows data from multiple users to be integrated

Smartsheet  • Cloud-based, meaning multiple users are able to work in 

the document at once to collaborate on tasks

 • Keeps track of time lines, calendars and task 

requirements

 • Rows can be expanded to see more detailed notes

 • Each row can have �les and emails attached to it and a 

discussion board linked to it

 • Contains a calendar view and alerts users of upcoming 

deadlines

 • Can import data from other programs, including Microsoft 

Of�ce and Google applications

 • Available as desktop software or mobile app
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7ere are many organisational and reporting requirements for an organisation that requires 
them to produce data and information to monitor their business. An organisation will refer 
to these requirements in their policies and procedures, which will be used to determine the 
resources available to the company, including the speci)c so&ware they can use. Be aware 
of the spreadsheet so&ware used in your organisation, and ensure you follow organisational 
policies and procedures. 

Review a blank worksheet

Before you start entering data into a spreadsheet, you should be familiar with 

various screen elements. 

Spreadsheets are made up of worksheets and workbooks. A worksheet is divided into 
columns and rows, and the intersection of a column and row is called a cell. 7e current cell 
is shown by a highlighted rectangle that is called the ‘active cell’. A workbook is a collection 
of worksheets.

7e following example is Sheet 1 in Book 1. A1 is the active cell.

If you look closely at this spreadsheet, you will notice there are a number of screen elements, 
as outlined here. 

Formula bar

 

A worksheet is made up of cells. The Formula Bar displays the current cell reference and is used to 

view and edit a cell’s contents. When entering data in a cell, you will see that cross and tick buttons 

appear on the Formula Bar. 

Accept your entry by clicking on the tick (or simply press the Enter key on the keyboard), or cancel it 

by clicking on the cross. 
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Title bar

The title bar includes the name of the workbook. It has the standard minimise, restore and close 

functions found in all Microsoft Of�ce products.

Ribbon – button tools

In Microsoft Excel 2016, toolbars have changed signi�cantly from earlier versions of the program. 

The program now operates by using a number of tabs available from the ribbon. These provide you 

with easy access to a wide variety of commonly used tools.

The ribbon has various tabs. You can easily switch between each tab to access tool buttons that you 

might need to use. 

There are also other tools that are relevant to an action you are performing. For example, when you 

choose to insert a chart, additional sets of tools appear under the Design, Layout and Format tabs.

Each tab has groups of tools available. For example, under the Home tab, the groups are Clipboard, 

Font, Alignment, Number, Styles, Cells and Editing.

You should familiarise yourself with the various tools that are available in Excel 2016. However, the 

most common tabs you will use are Home, Insert, Page Layout and View.

To learn about the various tool buttons, rest your mouse pointer on the button. A bubble will appear 

that brie y describes the tool.

Active sheet

Each new workbook you open in Excel contains three blank worksheets by default. It is possible 

to add or delete worksheets, and rename worksheets if you need to. For example, you may have 

a workbook that contains yearly sales data where each worksheet contains speci�c data (such 

as sales data for each quarter) and each worksheet is named appropriately; for example, Quarter 

1, Quarter 2, Quarter 3, Quarter 4. It is possible to view and work with data contained in each 

worksheet by simply clicking on the sheet name.

You can rename a worksheet by right-clicking on the existing name (e.g. Sheet1) and selecting 

Rename. Type in the new name and press Enter.

Enter data and select cells

Numbers and text can be typed into a cell. 

Text entries are called ‘labels’ and numeric entries are called ‘values’. To enter data into a 
cell, you must )rst select it to make it active. 7e le&-hand column contains a list of values 
that starts at 1 and increases as you go down the page. 7e top row contains a list of letters 
that starts from A and continues in alphabetical order across the page. Each cell therefore 
has a corresponding coordinate, e.g. C4, K12, etc.

Once you have entered data into a worksheet, you will need to select data in order to amend 
it, format it or perform calculations. You can alter the information in a cell by selecting the 
cell and directly entering the new information, or by using the Formula Bar. When you 
select a cell, you make it active and the cell’s content will be displayed on the Formula Bar. 
Here you can use the Insert Function (ƒx) button to insert a basic function or calculation.
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You may need to select some or all of the data in a worksheet. When data is selected, it is 
highlighted on the screen. 7e following information describes a number of techniques for 
selecting cells.

Select a group of cells by dragging the mouse

 └ Click on the �rst cell in the range that you want to select. Hold down the left mouse 

button and drag over the required cells. Alternatively, click on a cell to select it.

Select a row

 └ Click on the row number button; for example

Select a column

 └ Click on the column letter button; for example

Select the entire worksheet

 └ Click on the button
  

to the left of column A, or on the keyboard press Ctrl+A.

Select multiple ranges

 └ Select cells using any of the above methods and then hold down Ctrl before selecting 

the second range of cells.

Perform basic functions

Selecting cells allows you to perform basic functions, such as merging cells and 

automatically �lling a range of cells.

To merge cells, )rst highlight the cells that you want to merge by clicking inside the )rst 
cell and holding your mouse down as you drag down or across the page. Once the cells are 
highlighted, select Merge & Center.

 
You can also use the Fill option to automatically complete a row of cells. For example, if 
the same numerical value is needed across a row of cells, you can type the number in the 
)rst cell, then use the Fill option to drag the same value across. If you wish for the numbers 
to continue you can change the settings by clicking on the Auto Fill Options drop-down 
menu and selecting Fill Series.  
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Practice task 2

Part A

Question 1 

Explain why it is important that you �nd out information from your supervisor in relation to the 

following before you begin a task.

a. The purpose of the spreadsheet

b. The intended audience

Question 2 

What can be done to ensure the presentation requirements, such as layout and design of the 

spreadsheet, meets the professional and corporate image of an organisation?

Question 3 

Explain why it is important to speak to your supervisor and con�rm the delivery and time line for 

the development of your spreadsheet.
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Question 4 

If you need to collaborate on tasks with your colleagues and work in real time, which of the 

following software applications would you choose? Tick all that apply.

 � Microsoft Excel

 � Google sheets

 � Apache OpenOf�ce Calc

 � Smartsheet

Part B
Take the following steps to enter data in a spreadsheet:

1. Open Excel.

2. Highlight cells A2–E2 and select Merge & Center. Click inside the merged cells and 
type Current Clothing Label.

3. In the fourth row, enter the following in separate columns: 

• Month

• Income

• Expenses

• Pro)t 

• Clear Pro)t

Look at the example below to help you. 

4. Type January in cell A5 and select the cell. Use Fill to drag down and add the months 
until you reach December. Excel will automatically )ll in the months for you.

5. Enter the values in the example above under Income and Expenses. You will be using 
the values you enter in calculations later, so try to be accurate.

6. Click on the cell labelled ‘Clear Pro)t’. 7is cell is now current.

7. Click on the Formula Bar to select it, or press the F2 key on the keyboard. Change the 
word ‘Clear’ to ‘End’.
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8. Press Enter or select the tick  on the Formula Bar to con)rm the change.

9. Select one of the numbers you have entered in the Income column. Press the Delete key 
to delete the information. Enter a new number.

10. Save your worksheet in a suitable location on your hard drive and name it ‘Current 
Clothing’.

Storage, output and presentation

Once you have entered data into your worksheet, you need to know what the 

required output is, how it should be presented and where it should be stored. 

For example, your manager may need you to enter monthly sales )gures, for which a total 
calculation must be made. In this case you need to add a column with a label of ‘Total’. You 
may need to format your spreadsheet to match organisational requirements; for example, 
you may need to use a certain font type and size for labels, and precise information in the 
header and footer.

Where you store your spreadsheet depends on who needs the information. When you create 
a spreadsheet, you need to save it immediately. You can save it to your personal hard drive 
or to a shared drive on your organisation’s server. A server delivers information to other 
computers linked by a network. Ask your manager where you should save your spreadsheet 
to ensure that you are adhering to company protocols. 

Practice task 3

Question 1 

Describe the main purpose of a spreadsheet.
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Question 2 

Describe the following components of a spreadsheet:

a. Workbook

b. Worksheet

c. Cell

Question 3 

What key can you press to access the Formula Bar in Excel?

Question 4 

Describe how you can use the Formula Bar to alter data in a cell.
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Summary

• Ergonomics is about creating comfortable working conditions. Setting up a workstation 
to suit your physical requirements prevents undue stress and strain.

• Environmental factors in the workplace, such as lighting, noise and air quality, aDect the 
health of employees.

• Plan daily tasks and rest periods to prevent repetitive work being done for long periods 
of time.

• Performing exercises during the working day can help to prevent pain and discomfort.

• Conserving resources at work bene)ts the organisation by reducing costs, and helps 
to reduce the amount of greenhouse gas produced and the amount of waste going to 
land)ll.

• Spreadsheets are made up of worksheets and workbooks. A worksheet is divided into 
columns and rows, and the intersection of a column and row is called a cell.

• You can change the appearance of your spreadsheet to suit your organisation’s style and 
presentation requirements.
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Learning checkpoint 1 
Select and prepare resources

Part A
1. List some reasons why a person may suDer physical discomfort when spending a lot of 

time at a workstation.

2. For each reason you have listed, describe a solution that could relieve the physical 
discomfort.

3. Describe three types of o�ce equipment you could use to improve your posture and/or 
e�ciency at work. Explain the bene)ts of each piece of equipment.
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Part B
Read the case study, then answer the questions that follow.

Case study
Angelina works as an administration of�cer. Her main tasks are reception duties, word processing, 

handling the mail and �ling. Most days Angelina’s manager gives her urgent work in the afternoon 

that needs to be completed that day. Her time lines are always very tight and she often �nds that she 

has to work during her lunch hour and for an extra half-hour in the evening. She is always exhausted 

and is becoming stressed.

To make matters worse, Angelina �nds that work is often just dropped on her desk, which makes her 

desk disorganised and dif�cult to use. She can’t adjust her chair and there is glare coming from her 

monitor. She often leaves work with a headache and a backache.

1. List all the unsafe work practices Angelina is experiencing.

2. For each of the unsafe practices you have listed, describe a solution.

3. Describe why work organisation and ergonomics lead to better employee health.
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Part C
1. Which of the following data types would it be appropriate to enter and store in a 

spreadsheet? Tick all that apply.

 � Budget information

 � Payroll data

 � A report about health and safety

 � Taxation information

 � Superannuation contributions

 � A letter to a client

 � Sales targets

 � Bank reconciliation information

2. Select two of the following spreadsheet applications and identify two features of each:

• Microso& Excel

• Google Sheets

• Apache OpenO�ce Calc

• Smartsheet

3. Why is it important to make sure you have confirmed the purpose of your task, the 

audience and the presentation requirements with your supervisor? 

4. Give an example of what you can do to make sure you meet a deadline for the delivery 
of a spreadsheet task. 
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Part D
1. Create the following spreadsheet, which provides a summary of sales results for sales 

consultants at Henry Lewis Consulting & Co.

2. Alter the December )gures as follows:

• Hannah – 5909

• Joe – 2343

• Fredrick – 1231

• Simon – 2324

• Carolyn – 4358

• Nim – 13210

3. Save the document and name it ‘Henry Lewis – sales results’.
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When producing spreadsheets, you need to check the data you have entered 

for errors and make sure the content and format suit your organisation’s 

requirements. 

For example, you may need to proofread the data manually or use the spellchecker installed 
in the so&ware you use.

If you have been asked to produce a spreadsheet, be aware of when the spreadsheet is needed 
so you can have it completed on time.

If you experience di�culties when producing a spreadsheet, you need to know where to go 
for help; for example, you could use a paper-based manual or go online. You should know 
which websites have up-to-date information about the so&ware you are using.

In this topic you will learn how to:

2A Enter, check and amend data 

2B Use so&ware functions to format spreadsheets

2C Use and test formulas to con)rm output meets task requirements

2D Overcome problems with spreadsheet design and production
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When data is entered, Excel treats the data di"erently depending on whether it 

is text, numbers or dates/times.

Data entered into Microso& Excel worksheets 
consists of: 

• text, such as customer names and addresses, or 
product information

• numbers, such as quantities, customer numbers, 
pricing and sales )gures 

• dates or times, such as dates of sale, dates of entry 
and monthly date ranges. 

Data must be entered, checked and adjusted as 
per organisational and/or task requirements. For 
example, your organisation may prefer that dates be 
formatted as 27 Aug 18. So if a date was formatted as 
27/08/2018, it would need to be amended.

Data entry

To enter data into Excel, the cell in the worksheet must be active. 

Entering data into a blank cell only requires you to select the cell, type the data and press 
Enter on the keyboard. 7e data will then be contained in the cell.

7e automatic default for data entry in Excel is that each time you press Enter on the 
keyboard, the activated cell will move down through the worksheet.

To adjust the way this works (for example, to make the next selected cell the one to the 
right), select the File tab and click Options. Select Advanced and alter the Editing options 
by selecting the )rst drop-down list.

Numerical data

Some default settings apply when entering numbers.

When entering numbers, the automatic alignment will be to the right of the cell. 

2A Enter, check and amend data
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Sometimes numbers do not appear as you would expect them to, as in the following 
example. 7is occurs when the number is too long for the cell width. 

Adjust the width of the cell to correct this problem.

Date and time entries also align to the right of the cell. When you enter the data, date and 
time formatting is applied to the cell. Microso& Excel 2016 tries to match the formatting 
with the way the information is typed in.

Edit data

To edit data, it is necessary to activate the cell contents. 

A common processing problem occurs when people want to change the data; for example, 
from Simon Jones to Simone Jones. To change this, you can either select the cell and retype 
the whole name. Alternatively, you can double-click on the cell itself, or select the cell and 
either press F2 on the keyboard or click on the Formula bar. 7ese options allow you to edit 
a speci)c part of the entry, rather than having to retype the entire thing.

Sorting data 

Often, data needs to be sorted according to set procedures. 

For example, customers may need to be sorted alphabetically according to surnames and 
purchases may need to be sorted in date order or by customer reference number.

To sort the data alphabetically, go to the Home tab and select the Sort & Filter drop-down 
menu, then select Sort A to Z. 

You do not need to select the data; just make sure the cursor is located in the column you 
want to sort. Excel will recognise adjoined columns and rows, and sort them appropriately. 
Excel also recognises label headings and does not include these in the sorting. 

If, however, there are blank rows or columns, Excel will not include these in the sorting. If 
you want blank rows and columns to be included, select the data to be sorted )rst before 
selecting the sorting option you wish to apply.



34
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU212
Create and use spreadsheets

Validation rules

When creating a worksheet, you can add validation rules in cells to ensure that 

anyone else who adds data has to make entries in the correct format.

For example, you may want only numbers or dates to be entered into certain cells. To do 
this, you need to set validation rules in your worksheet.

To set validation rules, select the cells you wish to apply the rule to by dragging your mouse 
over them. 7en select the Data tab and click on the Data Validation drop-down menu.   

Select Data Validation to open a dialog window. Here you can set the criteria for what can 
be entered into the cells you have selected. For example, under Allow, select Text length to 
decide how many characters or digits you will allow in a cell. You can do this by placing a 
minimum and maximum value in the relevant )elds.

Once you have set a validation rule, if you try to enter too many digits in a cell, Excel will 
display the following message:

7is message tells you that your entry is invalid, but it does not tell you what you should 
enter. You can change the error message to tell a user exactly what should be entered into 
a cell. To do this, go back to the Data Validation dialog box and select the Error alert tab. 
Here you can change the error message that is displayed by typing a new one in the Error 
message box.

If you set a validation rule, always create an error message to help you and your colleagues 
enter the correct data.

Practice task 4

Follow these steps to set validation rules.

1. Open an Excel worksheet. Look at the following sample and enter the same data into 
your worksheet. 7is worksheet is to record product codes that have one letter and two 
digits. 7e month columns record the units of products sold in that month. Save the 
worksheet as Validation-rules.
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2. Select cells A5 to A12.

3. From the Data tab, select the Data Validation tool and select the Data Validation 

option to open the dialog box.

4. Under Allow, select Text length. 

5. Under Data, select between, then enter ‘3’ in both the Minimum and Maximum )elds. 
7is means only three digits or characters are allowed in each of the selected cells. Click 
OK to save these rules.

6. Select the Error Alert tab.

7. In the Error message box, type ‘You must enter one character and two digits’. Click OK.
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8. Now try to enter four digits into one of the worksheet cells you selected earlier 
(A5–A12). Excel should display the error message you typed in. 

Checking and proofreading data 

When using formulas and functions, you need to make sure that the result you 

get is correct. 

If you are working under tight deadlines, it is easy to make mistakes, such as subtracting 
one cell from another instead of adding them. 

Always test your formulas and functions before using them in your spreadsheet. You can do 
this by using a calculator to work out the result. Ensure the formula in your spreadsheet is 
correct by checking the result against the result in your calculator.

You should also check the consistency of information against the original data and check 
that the cell references, mathematical operators (symbols) and functions used are correct. 

Sometimes this is as simple as giving the information you have produced to a colleague or 
supervisor to check in dra& form before you complete the )nal version. 

You must always check your spreadsheets for accuracy. 7is may include double checking 
with your supervisor to make sure the data you have entered is correct.

As well as checking the values that are entered, you must make sure that any labels you 
have entered are spelt correctly and that you have formatted all data to suit organisational 
requirements.

Proofreading is the process of carefully reviewing a document for any mistakes. To 
proofread a spreadsheet, you need to check for errors in values and labels.

To check values, compare the values you have entered with the values you were given. Make 
sure that you have not made any errors when copying values and that you have entered all 
the data in the correct places.

To check errors in labels, you can use the Spelling function under the Review tab. 

7is will pick up words you have misspelt, but will not help you with product names, or 
customer names and addresses, so you will need to check these carefully. 

Following instructions about content and format

There are often guidelines or instructions for producing a spreadsheet, which 

help to communicate an organisation’s professionalism to those outside of the 

organisation. 

7ese may relate to the content of the spreadsheet or its format and layout. 

You may be asked to prepare a report about stock on hand and to arrange the data in 
product code order, highlighting the quantity on hand and the quantity on order. You may 
also be asked to cross-check product codes with the product description.

7ese are speci)c instructions on how to produce the spreadsheet. If these instructions 
are not followed, it may delay the )nal production of the spreadsheet. It may also aDect the 
accuracy of information.
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It is therefore important that care is taken in design and layout, and that it adheres to the 
corporate image of the organisation. O&en, an organisational style guide is developed so 
that there is consistency in the presentation and )nal look of the spreadsheets produced 
right across an organisation. 7is may include using standard templates. In many cases, if a 
standard template is used, prede)ned styles will automatically appear in the document. 

Clarify the use of house styles for your organisation with your supervisor and colleagues, 
and ask what the requirements are for the task you are going to undertake before you 
begin. If you have your own ideas on how the content or format of a spreadsheet could be 
improved, speak to your supervisor.

Practice task 5

1. Practise entering this data into a blank spreadsheet.

Name Address Phone number

Mary Buchanin 29 Green Rd, Altona 3018 9983 0194

Ginger Smith 988 City Rd, Melbourne 3000 9876 3939

Lionel Ha 1/23 Brown Rd, Laverton 3028 9762 8373

Ali Simoghin 21/1 Tree St, Williamstown 3016 9853 8391

When entering data:

• AutoFit the column width to enable all the data to be viewed.

• Sort the data from A to Z based on surnames.

• Save the worksheet as ‘Customer contacts’.

2. Look at these examples of a worksheet and documentation used to enter data.



38
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU212
Create and use spreadsheets

Customer documentation

Customers Balance

Smith 55.00

Carter 4,000.00

Andrews 3,455.00

Phillips 3,000.00

Elliot 2,500.00

Franks 5,000.00

Luie 34.00

3. Cross-reference the worksheet with the customer documentation. How many errors are 
there in the worksheet?

4. What should customer Smith’s new balance be?

5. Recreate the ‘Customer accounts’ worksheet with accurate information.

6. Select cells B5–F15 from the ‘Validation rules’ worksheet from the previous example. 
7is covers all the values to be entered under the )ve months. Add a validation rule to 
these cells that ensures only numbers can be entered into them. Write an error message to 
help colleagues if they try to enter the wrong data. Test your validation rule to make sure 

it works.
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When you have created a spreadsheet, some adjustments will be required to 

meet organisational requirements. 

For example, you may have to add columns and rows to enter new data, or resize columns 
and rows to )t data that has already been entered.

Adjusting cell settings

To ensure that all text is visible, you may need to adjust the cell settings.

When entering text, you will notice that a&er you have entered the data, it is automatically 
aligned to the le& of the cell. You will also notice that if there is no data in the adjacent cell, 
the text will overJow across adjacent cells.

If there is data in the adjacent cell, the text that is entered becomes hidden behind the edge 
of the cell. 

Many people are confused by this and think that the data is lost. However, it is still 
contained in the cell. If you select the cell again, you will notice that the Formula bar (at the 
top of the sheet) shows the full content of the cell. 

To ensure the printed and on-screen versions of the document both show the full content 
of the cell in the worksheet, you need to adjust the width of the cell. Alternatively, you can 
wrap the text inside the cell and adjust the height if necessary. 

2B Use software functions to format spreadsheets
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Adjust cell width

Position your cursor between the column headings at the top of the worksheet. The 

cursor should change into a two-headed arrow.

Click and drag the cursor right or left to where you want the width of the cell to be.

Alternatively, you can ‘AutoFit’ the cell width by double-clicking between the column 

headings. The columns will automatically adjust to match the width of the longest entry.

Adjust cell height

Move the cursor to the horizontal line between the row numbers. The cursor should 

change into a two-headed arrow.

Click and drag the two-headed arrow up or down until the row is the required height.

Wrap text

To wrap text in a cell, select the cell and use the Wrap Text tool, which is located on the 

Home tab. The height of the cell should automatically adjust to �t the text.

You can also adjust the height and width of cells by selecting the Format drop-down menu 
in the Home tab. From here, select either Row height or Column width and enter the 
number you wish to change it to.

Inserting new columns and rows

Inserting new columns and rows enables additional data to be entered.

To insert a new column, you can either select a cell or the entire column to the le& of where 
you would like a new one to be inserted (you can select the entire column by clicking on the 
letter at the top of the column). 7en go to the Home tab and select the Insert drop-down 
menu. Select Insert Sheet Columns and a new column should appear to the right of the 
column you selected.

To add a new row, select the cell or row below where you would like the new row to be 
inserted (select the row by clicking on the relevant number on the le&-hand side). 7en 
select the Insert drop-down menu and select Insert Sheet Rows. A new row will appear 
above the one that was selected.

To delete a row or column, select the relevant cell, row or 
column, then select the Delete drop-down menu in the 
Home tab.  

Select the appropriate option (Delete Sheet Rows or Delete 
Sheet Columns). 7e remaining rows or columns will 
automatically shi& up or across. You can also choose to delete 
an individual cell. 
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Practice task 6

Take the following steps to insert a new column in a spreadsheet.

1. Open your Current-Clothing spreadsheet.

2. Select Column E, which should now be titled ‘End pro)t’.

3. Go to the Home tab and select the Insert drop-down menu. Select Insert Sheet 
Columns to insert a new column to the le& of ‘End pro)t’.

4. Select cell E4 and label the new column ‘Tax’. 7is column is to calculate the tax on 
monthly income. 

5. It should look like the following example. Save the changes and close the worksheet.
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Cell alignment

As discussed previously, text and values align di"erently within cells by default: 

text aligns to the left, numbers to the right. 

To adjust the horizontal alignment of data in a cell, simply select the cell or cells and choose 
the appropriate alignment tool from the Home tab.

 
Horizontal alignment options include le&, centre and right.

7e alignment of data in a cell can also be adjusted for the height of the cell. Data can be 
aligned to the top, centre or bottom of a cell. 7e default is to align the text to the bottom of 
the cell. 

To adjust the vertical alignment of data in a cell, simply select the cell and choose the 
appropriate alignment tool from the Home tab.

 
7e direction of text can also be changed to a vertical or diagonal alignment by selecting the 
Orientation icon.

 
Another common tool used to align cells is the Merge & Centre tool. 7is is commonly 
used to align a heading across the width of data in a spreadsheet. 

In the following example, the heading ‘Henry Lewis Consulting & Co’ and the heading 
‘Sales results’ have both been merged and centred across columns A to G (A:G).

To perform this action, select the cells you wish to merge and then select the Merge & 
Center tool in the Home tab.

 
You can also use the arrow to open the drop-down menu and select Merge Across if you do 
not want the contents of the cell to be centred.

Centre data on the page

The default alignment for printing a spreadsheet is that the data is aligned to 

the left and top of the page in line with the margins. 

In many cases, especially in smaller reports, it is preferable to centre the data on the page 
both vertically and horizontally. 

To do this, select the Page Layout tab. Select the Margins drop-down menu, then select 
Custom Margins.
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Check the options to centre on the page both Horizontally and Vertically. 7e display in 
the dialog box shows how the changes will appear in the spreadsheet. You can also select 
Print Preview to see how data will be displayed on the page. Select OK. When printed, the 
data will now be aligned vertically and horizontally on the page. 

Orientation of a spreadsheet

When printing a spreadsheet, the default setting is set to print in portrait 

orientation. 

Due to their layout, owever, it is common for Excel reports to be printed in landscape 
orientation. In most cases, this is because the reports contain more data that spreads across 
the page, rather than down the page. 

To alter the orientation of your report, select the Page Layout tab, then select the 
Orientation drop-down menu and select Landscape.

If not all of your data appears on one page and some spills over to the next, you can force 
the data to be scaled to the size that you prefer (that is, 80% of size or )t one-page wide by 
one-page tall). Go to the File tab, then select Print. You can change the scaling options 
using the drop-down menu under Settings.
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Simple calculations in Excel

Routine or simple calculations are often performed in Excel to calculate data.

Excel is used to calculate a variety of data; for example, in )nancial reports, sales statistics 
and stock levels. 

An Excel calculation always starts with an = sign and can include any of the following 
mathematical operators:

• * (multiply) 

• / (divide)

• + (add)

• – (subtract) 

• % (per cent) 

• ^ (exponential)

Mathematical rules

The mathematical rule of BODMAS is applied in Excel spreadsheets when 

performing calculations. 

BODMAS refers to the order of operations and stands for: 

• Brackets 

• Orders

• Division and Multiplication 

• Addition and Subtraction

7is means that anything inside brackets is calculated )rst, then division/multiplication is 
calculated in the order it appears, then the remaining numbers are added or subtracted in 
the order they appear.

Calculations can be performed either on values (e.g. 1, 2, 3) or on the cell reference (e.g. A1). 
When calculating data, it is always better to use the cell reference (e.g. A15), as opposed to 
the value (e.g. 783). 7is ensures that the data entered is accurate, as the information is taken 
directly from the cell instead of you having to retype it. 

It also assists by saving time – for instance, if the data in the cell changes, the calculation 
will be updated automatically as long as you used the cell reference.

Formula e,ciency

Great care needs to be taken to ensure that the data entered is accurate.

If you make an error when typing or entering the data or cell reference, the calculation will 
be incorrect. If you choose the incorrect operator (for example, *, +, /, –) for a calculation, 
the result will also be incorrect. 

You need to manually check the values entered, as well as the cell references, and to be 
familiar with the operators and functions that you use.

7e use of formulas and functions saves a lot of time when preparing reports and 
statistical data.
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As discussed earlier, it is always best practice to use cell references (e.g. A1) where possible in 
calculations. 7is ensures that the data is accurate and also saves time if the data in the cell 
changes, as the calculation will be updated automatically. 

In addition, it is a better habit to use your mouse to select the cell reference, as opposed to 
typing it in, to ensure you have selected the correct information for the calculation. 

All calculations begin with the = symbol. If this is not present, Excel will not recognise the 
entry as a calculation, but will assume that it is simply a text entry.

Format spreadsheets

You can change the appearance of your spreadsheets to suit your 

organisation’s style and presentation requirements. 

You can adjust the appearance of a cell’s content by altering how it is aligned, its font and 
whether it has a border or pattern. If the cell has a numerical value, you can change how 
this value is displayed by converting it into currency, a percentage, a fraction or a scienti)c 
number. 

You can also make data in your spreadsheet more noticeable by using borders and shading. 
A border alters the appearance of the cell wall and shading alters the colour of the cell. 

Find out the style and presentation requirements for spreadsheets in your organisation. 

Formatting your spreadsheet has a number of advantages:

 • It creates an ef�cient layout to make the information clearer and easier to read.

 • It makes data input easier.

 • It ensures your spreadsheet complies with organisational style and presentation 

requirements.

Practice task 7

Take the following steps to format labels (text entered into cells) and values (numbers 
entered into cells).

1. Open the ‘Current clothing’ worksheet.

2. Select the cell labelled ‘Current clothing label’.

3. From the Home tab, select Font Settings by clicking on the icon in the bottom right 
corner of the Font section. This will open the Format Cells dialog box.
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4. Under Font, select Garamond, then select Bold Italic under Font style, and choose size 
18. Click OK.

5. Select cells A4–F4. 7is should cover all the headings of your columns.

6. Using the Font tools in the Home tab, change the font selections. Select Garamond, 
Bold, 14.

7. Select cells A5–A16. 7is should cover all the month labels.

8. Using the Font tools, change the font selections to Garamond, Bold, 12. Click OK.

9. Adjust the column widths to suit the formatting. 7e worksheet should now look like 
the following example. 

10. Select cells B5–F16. 7is will select all the cells where values have been input.

11. From the Home tab, select Number Format by clicking on the icon in the bottom right 
corner of the Number section. 7is will open the Format Cells dialog box.
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12. Under the Number tab, select Currency. Check that the symbol is a dollar sign ($) and 
adjust if required. Click OK. Your values should now be formatted as currency. If some 
of your values are not displayed correctly, adjust the column width until they are clearly 
displayed.

Practice task 8

7e following steps show how to add borders and shading to cells in the spreadsheet.

1. Open the ‘Current clothing’ worksheet.

2. Select cells A4–F4. 7is should cover all the headings of your columns. 7en hold down 
Ctrl and select cells A5–A16. 7is should cover all the month labels.

3. From the Home tab, access the Format Cells dialog box by selecting  in the Font 
section. 

4. Select the Fill tab in the dialog box. Select a pale colour and click OK. 

5. View the colour on your spreadsheet; feel free to change it if you don’t like it.

6. Select cells A1–F19. 7is should cover all the content in the spreadsheet. Access the 
Format Cells dialog box again and select the Border tab.
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7. Select a style of your choice, then select Outline. Click OK.

8. To view your formatting, select the File tab, then select Print.

9. Select the Home tab to return to your spreadsheet. 

Practice task 9

In this exercise, you will add a header and footer to your spreadsheet. 

7e following steps show how to add a header and/or footer.

1. Open the ‘Current clothing’ worksheet.

2. From the Insert tab, select the Header & Footer tool.
 

3. Now there should be a header section in your document for you to work in. 7ere will 
also be a new group of tools available for you to use under a Design tab.

You can type directly into the header section or you can use the new tools to insert 
useful information such as a date or page number.

4. To insert a footer, select the Go to Footer tool in the Design tab and type directly into 
the footer section, or use the Design tab tools to insert page numbers, a date, time and 
)le path.

5. Using these options, insert an appropriate header and footer into the spreadsheet.

6. Go to the File tab and select Print to preview the spreadsheet. If you are unhappy with 
its appearance, make appropriate changes.

7. Save and close your worksheet.
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Practice task 10

Question 1 

Remembering the order in which Excel performs functions, work out the following calculations.

a. =23+24*2

b. =20+40*5

c. =100+2+30*4

d. =(15-5)*5

Question 2 

Create this spreadsheet, which provides a summary of sales results for sales consultants at 

‘Henry Lewis Consulting & Co’. Then complete the tasks that follow.



50
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU212
Create and use spreadsheets

 • Use Fill to create the list of months.

 • Alter the December �gures as follows:

 – Hannah: 5909

 – Joe: 2343

 – Fredrick: 1231

 – Simon: 2324

 – Carolyn: 4358

 – Nim: 13210

 • Save the document and name it ‘Henry Lewis – sales results’.

 • Use the alignment tools to alter the width and height of columns and rows.

 • Use the Merge & Centre tool to create headings for the spreadsheet.

 • Centre the data on the page both horizontally and vertically.

 • Change the orientation from portrait to landscape.

 • In a new column labelled ‘Summary monthly totals’, calculate the total sales �gures for each 

month, e.g. =B6+C6+D6+E6+F6+G6 (Make sure you use the mouse to point and select 

each cell reference).

 • Manually check the calculations using a calculator.

 • Change the font type to Arial 14pt.

 • Bold the heading and the summary monthly totals.

 • Italicise the month and sales consultant labels.

 • Adjust the column width as needed.

 • Use the Number Formatting tools to make sure all commission and total �gures are 

displayed in currency ($) with two decimal places.

 • Adjust the column width as needed.

 • Place a dark border around the outside of the data. 

 • Using the Fill tools, shade the list of names and associated data green and then shade the 

summary total a different colour. 

 • Shade the month names the same colour as the summary total. Shade the report heading a 

different colour. 

 • Add a header with today’s date and time.

 • Add a footer that displays the page number.

 • Select Print in the File tab to print preview the report.

 • Save your changes and close.
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Formulas and functions in Excel are used to perform calculations. 

A formula is an equation that performs calculations on data. It is used to calculate 
numerical data. Formulas and functions can include cell references and mathematical 
operations such as addition and subtraction. For example, =D5+E6 is a formula.

A function is a calculation that uses a mathematical, statistical or )nancial operator. Excel 
provides a range of commonly used functions, such as SUM and AVERAGE. For example, 
=SUM (B5:B17) uses the SUM function to add all the values in the selected cell range.

Depending on your organisation’s requirements, you may have to use values in your 
spreadsheets to generate new values, such as the GST of a product or service, or an 
increase in product prices. Formulas and functions allow you to generate new values using 
existing values.

When creating a formula in Excel, use the cell references in your calculations. For example, 
=A3+B3 adds the values in the cells A3 and B3.

Practice task 11

7e following shows how to create a formula to calculate values for the Pro)t column in the 
‘Current clothing’ worksheet. 

1. Open your ‘Current clothing’ worksheet.

2. Select D5, the )rst empty cell under ‘Pro)t’. Enter the formula =B5–C5.

2C  Use and test formulas to con1rm 
output meets task requirements
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3. Press the Enter key to perform the calculation.

4. Once you have a calculation, you can use Fill to perform calculations in the remainder 
of the column. Click and drag the D5 Fill handle down to D16. Your worksheet should 
now look like the following example.

5. 7e values in the ‘Tax’ column need to be calculated as 10 per cent of the pro)t. In E5 
enter the formula =10%*D5 (this will give you 10 per cent of the value in D5). 

6. Press the Enter key to perform the calculation. Fill the calculation down to December.

7. Select F5, the )rst empty cell under ‘End pro)t’. Enter the formula =D5–E5. 7is 
calculation subtracts ‘Tax’ from ‘Pro)t’, giving you the end pro)t values.

8. Press the Enter key to perform the calculation. Fill the calculation down to December.
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Simple functions

Functions can be used in Excel to perform a variety of mathematical, statistical 

and �nancial calculations. 

As well as adding up values, functions can also determine values such as the maximum, 
minimum or average from a range of cells.

7e AutoSum icon  is under the Home tab in the Editing grouping. AutoSum enables you 
to add values automatically using the SUM function. Simply select the range of values that 
you want to calculate and click the AutoSum icon.

Use the Fill handle  to repeat the sequence of the function.

7e following outlines some other simple Excel functions.

=SUM(range)

 └ This adds the values speci�ed in the brackets.

=MAX(range)

 └ This returns the highest value from the values speci�ed in the brackets.

=MIN(range)

 └ This returns the lowest value from the values speci�ed in the brackets.

=AVERAGE(range)

 └ This returns the average value calculated using the values speci�ed in the 

brackets.

=COUNT(range)

 └ This counts the number of items in the range.

=NOW()

 └ This inserts the current time and date.

=RAND()

 └ This inserts a random number between 0 and 1.
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Practice task 12

Take the following steps to use a function to calculate totals in the ‘Current clothing’ 
worksheet. 

1. Select cell A18 on your worksheet and type ‘Totals’.

2. Select cell B18. Go to the Formulas tab and select the Insert Function button.
 

3. You will see the following Insert Function dialog box. Highlight SUM and click OK.

4. As you have selected a cell at the end of a column full of numerical values, the SUM 
function will add all of these values together. Number 1 shows the formula that the 
SUM function will use to make the calculation and the formula result is displayed at the 
bottom of the dialog box. Click OK.

5. Cell B18 should now hold the calculation of all income values added together.

6. Select the cells C18, D18, E18 and F18 one at a time and use the SUM function to add the 
values of their corresponding columns. Your worksheet should now look similar to the 
following example.
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Relative and absolute cell references

The cells in an Excel spreadsheet are all relative to each other. 

7is means that if you place a value in one cell and then move it, the values will alter as the 
cell collects information from other cells around it. 

For example, the totals you calculated for each of your columns may need to be moved to 
another part of the spreadsheet. However, if you move these totals to another location, their 
values will alter as the cells are no longer reading information from the cells immediately 
above them. 7is kind of reference is called a relative reference. 

To make the values remain the same wherever you place them in the spreadsheet, you need 
to make the reference ‘absolute’. To make a cell reference absolute, you need to place the $ 
symbol in the reference. Here is an example of the diDerence between a relative reference 
and an absolute one.

Type of reference Formula example

Relative =C5+B5

Absolute =$C$5+$B$5
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Practice task 13

Take the following steps to create an absolute reference.

1. Open the ‘Current clothing’ worksheet.

2. Select B18, which should be the ‘Income’ total.

3. In the formula bar you should see =SUM(B5:B17). Click in between B and 5. 7e 
formula should turn blue. Press the F4 key.

4. 7e formula should now read =SUM($B$5:B17). 

5. Click in between B and 17 and press the F4 key. 

6. 7e formula will now read =SUM($B$5:$B$17).

7. To con)rm the formula, press the Enter key. 7e B18 reference is now absolute.

8. Repeat the absolute cell reference process with the C18, D18, E18 and F18 references.

Test your absolute reference creation by copying and pasting any of your absolute references 
into an empty cell. 7e value of the absolute reference you choose should remain the same 
wherever it is placed.

Test, adjust and con1rm formulas

The formulas used in a spreadsheet must be appropriate for the data that needs 

to be produced, and need to be tracked for errors.

It is important that cell references are used to track any calculation errors in a report.

Excel has many features to assist you in identifying errors, including a green triangle symbol 
that appears in the top le& corner of a cell if there is an inconsistency in a formula.

If you select the cell with the alert and hold your pointer over the green triangle, a help 
bubble will appear to explain the error that has been identi)ed by Excel.

7is helps you investigate and compare this formula to other similar formulas in the 
spreadsheet to )nd out where the problem might lie and ultimately )x the error.

Once you have investigated the error, you can choose the option to ignore the warning if 
there is no error. 7is will remove the green error Jag from the spreadsheet.
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Formula auditing tools

Formula auditing tools are useful when you are investigating errors and 

working out how to �x them.

To access these tools, go to the Formulas tab. 

7e Show Formulas tool changes the view so you can reveal or hide all the formulas in the 
spreadsheet. 

Another useful tool is the Trace Precedents tool, which shows where the data in the 
calculations comes from. 7is is useful for tracking errors. To use this tool, you )rst need to 
select the cell that contains the error and then select Trace Precedents. 7e spreadsheet will 
show preceding connections, which you can use to determine the root of the problem. 7e 
following shows an example of this tool in action.
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Task requirements

Most organisations have developed policies and procedures for how reports are 

to be presented. 

Paying attention to the presentation of your document will enhance the reader’s ability to 
understand it. It is important to ensure that the contents of any report you are producing are 
accurate and meet the requirements for the purpose and audience it is intended for. If you 
are unsure, ask your supervisor to check your work to con)rm it meets the requirements 
and that you are doing your job correctly.  

As part of the production process, it is necessary to check all information, including:

 • names, addresses and phone numbers

 • product information and pricing

 • dates

 • reference details (such as customer number and product code)

 • spelling

 • �gures and calculations

 • document-speci�c facts (such as summary totals and highlighted information for 

action or review).

Check information

If the information contained in the spreadsheet is not accurate, it can cause 

problems for your organisation. 

For example, if you work for a retail outlet and are 
asked to keep a record of daily sales, you might 
accidentally mistype Monday’s daily sales as $43,000 
when it should have been $4,300. 7is would aDect 
not only the spreadsheet that you are preparing, 
but other )nancial reports that determine pro)t 
and loss. 7is could then aDect decisions made by 
management, such as the number of staD required to 
work on a particular day.

Taking the time to check information and making 
sure that it is correct helps to save time and improve 
o�ce e�ciency. Checking information and report 
requirements with colleagues, supervisors and 
managers assists in the preparation of reports that 
meet the organisation’s needs.

It is also important that you undertake manual checks as necessary. 7is could mean 
checking values against the original data, using a calculator to verify results, and discussing 
problems and calculations with colleagues and supervisors. 



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

59

Topic 2
Create simple spreadsheets

Practice task 14

Part A
Enter this data into a new worksheet, then complete the tasks that follow.

• Calculate the January commission using cell references; for example, =B3*C3 will 
calculate Mary’s January commission.

• Using AutoSum, calculate the total of the January commissions.

• Using the MAX function, calculate the highest commission.

• Using the MIN function, calculate the lowest commission.

• Using the AVERAGE function, calculate the average commission.

• Save the )le as ‘January sales commissions’.

Part B
Read this case study, then complete the tasks that follow.

Case study
Daisy works as an administrative assistant in a large of�ce. One of her tasks is to create 

spreadsheets. Her supervisor has asked her to create a spreadsheet with the cost price and selling 

price of various products. Daisy then has to calculate the new price of stock after a 20 per cent 

discount. To calculate the discount of the value in B5, she uses the formula =10%*B5. To calculate 

the ‘Sale price’ to be shown in D5, she uses the formula =SUM(B5:C5).

Daisy’s results look like this.
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Question 1 

Explain the mistakes Daisy has made in her calculations for the ‘Discount’ and ‘Sale price’ 

columns.

Question 2 

What could be the consequences of the organisation using this data?

Question 3 

Rewrite the functions for the ‘Discount’ and ‘Sale price’ columns.

Question 4 

Describe what Daisy could have done to make sure her calculations were accurate.
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You may need to access help when producing Excel spreadsheets to learn more 

about how an Excel function works or to help you operate a printer. 

Whatever the problem, you need to have a plan in place for dealing with the unexpected. 
Organisations usually have a number of ways of dealing with so&ware or hardware 
problems. 7ey may have manuals or training booklets for you to look at or they may have 
an IT helpdesk for employees.

Here are some examples of possible problems.

Hardware

 └ Your monitor stops working.

Software

 └ Your software has been upgraded and you are unsure how to use it.

Formatting

 └ You want to add borders and colour to your spreadsheet, but are not sure how 

to.

Layout

 └ You want to change the orientation from portrait to landscape and need help 

doing this.

Formulas

 └ You want to know why a formula seems to be giving the incorrect answer.

Function

 └ You want to know how to use the AVERAGE function.

Printing

 └ You want to know how to print using the colour printer.

2D Overcome problems with spreadsheet 
design and production
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Excel Help

When working in Excel, you can use the help facility to assist you with certain 

functions. 

Each time you move your mouse cursor over a tool button, it will display a bubble that tells 
you what the button is used for.

For instance, in the Home tab, if you move your cursor over the font tool, you will see this 
message.

Many of these bubbles have a Tell me more link, which connects directly to the relevant 
help page.

Alternatively, you can search for speci)c things you need help with by typing keywords into 
the search bar.

Full access to the help facility requires you to be connected to the internet. However, you 
can access standard help facilities oZine.

You can also press F1 on the keyboard to access the help facility.
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Manuals and training booklets

You can refer to user manuals and training booklets for instructions on how to 

carry out certain functions in Excel.

Excel so&ware comes with user manuals that describe the so&ware’s features and provide 
step-by-step instructions for carrying out diDerent functions. You can )nd manuals in print 
and electronic formats. 

7ere are many websites where you can )nd information about Microso& O�ce 
applications. 7ese websites contain solutions to common problems and frequently asked 
questions (FAQs). You can also download updates, tools and any )xes that Microso& has 
developed for so&ware problems. 

You may )nd the following websites useful:

http://aspirelr.link/microsoft-support

This is Microsoft’s main site for �nding help to solve problems for all Microsoft products. 

You can ask questions online and download �les, including service packs, drivers and 

patches. This site also gives you access to the Microsoft Knowledge Base, which offers 

help for problems that can be experienced when using Of�ce 2016.

http://aspirelr.link/microsoft-of�ce

This site provides resources for all Microsoft Of�ce applications. It has news and 

announcements, as well as useful �les you can download. If you are connected to the 

internet, you can open this site directly through the help facility.

Additionally, you may have received training in using Excel by attending an external 
training course or one oDered by your organisation. Training materials are a useful resource 
to refer to as they usually provide a comprehensive set of instructions on how to carry out 
certain tasks.

Practice task 15

Read the case study, then answer the questions that follow.

Case study
Chinh works as an administrative assistant in a small manufacturing organisation. One of his tasks 

is to create Excel spreadsheets for his supervisor. When creating spreadsheets, Chinh often needs 

to use the help facility to assist him with various software functions. If he is unsure of a screen icon’s 

function, he points to the icon with his mouse and reads the help bubble.

Recently Chinh attended a two-day Excel training course at a local community centre. He kept the 

training booklet given out and stores it on his bookshelf at work. It has a handy index at the back 

for quick solutions to problems. He has also photocopied pages from various manuals he has found 

around the of�ce and placed them in a help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be solved using Excel’s help 

facility. When this occurs, he accesses Microsoft’s support website to �nd a solution or refers to the 

material he has gathered.
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Question 1 

If Chinh experiences software functionality problems, where does he go for help?

Question 2 

Describe how Chinh uses manuals and training materials for help.

Question 3 

If you experience a software problem when creating a spreadsheet, describe the steps you 

should take to solve the problem.

Summary

• Organisations use Excel spreadsheets to record numerical data and perform 
calculations. 

• You may need to adjust the height and width of columns and rows to )t the data.

• Formulas and functions are used in Excel to perform calculations.

• When using formulas and functions, make sure the result is correct. 

• You can change the appearance of your spreadsheet to suit your organisation’s style and 
presentation requirements.

• Always check the data to make sure it is accurate.

• To solve problems when producing a spreadsheet, make sure you have access to online 
and oZine materials to help you.

• You can access the help facility in Excel at any time by pressing the F1 key.
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Learning checkpoint 2 
Create simple spreadsheets

Part A
Read the product documentation and the product pricing worksheet, then answer the 
questions that follow.

Product documentation

Product Code Price (before GST)

E334 $1700.00

E343 $1200.00

E788 $1500.00

E708 $1000.00

E356 $8000.00

E376 $2500.00

Product pricing worksheet
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1. Proofread the product pricing worksheet against the product documentation. What 
major errors have been made by the person entering the data into the worksheet?

2. In the worksheet, the actual price of product E343 is given as $1,530.00. What is the 
correct actual price of this product?

3. What is the correct GST for product E788?

4. What is the correct actual price for product E356?

5. Which value on the worksheet is correct?

6. Describe the consequences of entering incorrect data. How can you prevent incorrect 
data from being entered into a spreadsheet?
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7. How does the using the organisational style guide help you with consistency of design 
and layout of a spreadsheet?

Part B
Recreate the following spreadsheet.

1. Format the labels to make data input easier.

2. Add borders and light shading around cells A11–F11. Format cells B11–F11 as Bold.

3. Merge cells B12–F12, format as Bold and align le&.

4. Add borders and darker shading around cells A12–F12.

5. In cell B11, write a formula that calculates Monday’s totals. Use a calculator to check that 
the formula gives the correct amount. Use Fill to apply the formula to each daily total.

6. In cell B12, write a formula that calculates the weekly total. Use a calculator to check 
that the formula is correct.

7. Print preview your spreadsheet. Adjust the alignments of your labels and values until 
you are satis)ed with how your spreadsheet looks. Print out your spreadsheet. 

Part C
Recreate the following spreadsheet by entering the data into each cell. 7e ‘Hourly rate’ is 
how much each person is paid per hour and the ‘Weekly hours’ refers to how many hours 
are worked per week. 

Use Excel help facilities to assist you to produce the spreadsheet if necessary, then complete 
the steps that follow.
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1. Format all the text labels so they are Arial, Bold, 10. Add a pale colour to all the cells 
with text labels. Add a border to the cells ‘StaD salaries’ and ‘Total weekly salaries’.

2. In D3, write a formula that calculates Joanne’s weekly salary. Use a calculator to check 
your formula. Use Fill to add the values for the remaining salaries.

3. All staD are going to receive a salary raise of 15 per cent. 7e ‘Salary rise’ column 
should show 15 per cent of the values in the Salary column. Use a calculator to work 
out 15 per cent of Joanne’s salary. In E3, write a formula that calculates 15 per cent of 
Joanne’s salary. Use a calculator to check your formula. Use Fill to add the values for the 
remaining salaries.

4. 7e ‘New weekly salary’ column should hold the value of the ‘Weekly salary’ and the 
‘Salary rise’ columns added together. In F3, write a formula that adds up Joanne’s 
new salary. Use a calculator to check your formula. Use Fill to add the values for the 
remaining salaries.

5. 7e value in D13 should contain all the ‘New weekly salary’ values. In D13, write a 
formula to add up all the ‘New weekly salary’ values. Make the cell reference of D13 
absolute.

6. Select cells D3 to F11 and set to currency with two decimal points.

7. Print preview your spreadsheet. Adjust the alignments of your labels and values until 
you are satis)ed. Print out your spreadsheet.
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A chart is a graphical representation of selected worksheet data. 

Charts are used to visually represent numerical data. It is usually easier to analyse columns 
and rows of numerical data if they are displayed in a chart. Charts make it easy to spot 
trends, highlight changes and compare )gures over a period of time.

7e best type of chart to use will depend on the type of data being converted into a chart; 
for example, you might choose a pie chart to show one data series and a column chart 
to show multiple data series. How you format a chart will depend on organisational and 
task requirements. Formatting a chart enhances the presentation and readability of the 
information.

In this topic you will learn how to:

3A Select a chart type and design to represent numerical data

3B Create charts

3C Use formatting features to modify the chart type and layout
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When producing charts, it is important to follow both organisational and task 

requirements. 

An organisation may have a set preference for the type of charts it uses. For example, it may 
prefer to use column charts as opposed to line charts because they make it easier to analyse 
the information. An organisation may also use certain colour codes for the presentation 
of data; if this is the case, these rules should be followed to ensure the organisation’s image 
remains consistent.

Task requirements can depend on a set of instructions and protocols in the production of 
charts. You may be asked to prepare a summary report of monthly sales as well as a chart. If 
this is the case, you may need to produce two documents. If the policy is that a certain type 
of chart design is used for the production of various reports, you need to do this. 

If you have any suggestions for improving the readability and analysis of charts and their 
associated data, discuss them with your supervisor or manager.

Types of charts and their features

If you are using an Excel spreadsheet, you will be able to display your data in a 

chart. 

7e types of charts you can create in Excel include: 

• area chart

• bar chart

• column chart

• pie chart

• line chart

• scatter chart.

Charts are visually appealing and make it easy to see data and absorb information at a 
glance. 7ey also help you to recognise any patterns and trends. 

7e following example shows the percentages of types of cakes sold in a bakery presented in 
a pie chart. It is easier to look at the cake shop data in a chart than to look at the )gures in a 
worksheet.

Charts are linked to information contained in the selected cells. 7is means that if the cell 
data is updated, the chart is updated accordingly.

7e kind of chart you choose and its design should reJect your organisation’s needs. 

3A Select a chart type and design to 
represent numerical data
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Area chart

Area charts can be used to demonstrate changes over time. 

For instance, they may be used to compare changes to sales over a given time. Area charts 
highlight total values across a time line. 

7e following example shows how yearly real estate sales )gures vary for diDerent outlets.

Bar charts

A bar chart displays information as a series of horizontal bars. 

7ese charts are useful for comparing data arranged in columns or rows. Bar charts show 
the diDerences between individual items.

7e following example shows how monthly sales vary for diDerent departments of a 
retail outlet.

Use a stacked bar chart to compare the values of individual totals to a total across categories. 

7e following example compares monthly department sales )gures, as well as the total 
overall amounts for the sales quarter.
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Column charts

A column chart has vertical columns and is useful for comparing separate types 

of data from a data series. 

7e following example shows how rainfall data in Sydney and Melbourne can be compared 
using a column chart.

If you prefer the 3D look for your column chart, choose 3D when making your chart 
selection.

Use a stacked column chart to compare the values of individual totals to a total across 
categories. 

7e following example compares monthly rainfall for Melbourne and Sydney, as well as the 
total overall amount.
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Pie charts

A pie chart shows a data series in percentage segments. 

It is useful for showing data as a percentage of a whole. Pie charts are commonly used to 
show which products are selling or how much market share an organisation has. 

7e following example of a two-dimensional pie chart shows the market shares of )ve health 
food companies.

If you prefer the 3D look for your pie chart, choose 3D when making your chart selection.
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Line chart

A line chart shows the movement of values in a data series using single or 

multiple lines. 

It is useful for showing how the values of a data series can change over time. 

7e following example uses a line chart to compare total monthly rainfall in Melbourne 
and Sydney.

Scatter chart

A scatter chart is used to compare and arrange data to analyse the 

relationships between numerical information. 

A scatter chart displays clusters and is commonly used for statistical comparisons. 

7e following example uses a scatter chart to display and analyse estimated and actual sales 
results. 
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Practice task 16

Read the case study, then answer the question that follows.

Case study
Hemline Miller is a boutique fashion chain specialising in womenswear. Each outlet regularly 

provides a monthly report on trade, including sales �gures, customer numbers and quantity of stock 

sold. Liza Guilano, the business owner, is happy with these reports. However, she realises that some 

of the newer store managers are �nding the information cumbersome to interpret. 

Liza has decided that in addition to the reports, she would like to trial preparing the information as a 

chart that compares the data for each of the outlets. She believes that a graphical representation of 

the data will be easier for the managers to decipher and compare.

As you are the of�ce manager, Liza asks you to prepare an example of how the data would be 

presented in chart form. She asks you to use bright colours in the charts, as this complements the 

style and colour range of the business. She also asks you to present the information as column 

charts, with values and stores identi�ed in the chart. It is important that there is a heading on each 

of the charts to clearly identify the information that is being reviewed.

What are the organisational and task requirements for producing the charts?
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Before you start to produce charts, you should become familiar with the terms 

used when referring to parts of a chart. 

7e following information explains the meanings of terms you need to know.

The data 

range is the 

selection of 

values you 

choose from 

a worksheet to 

place in a chart; 

for example, all the 

numbers in one row or 

one column of data.

The legend 

is the key 

used to 

identify the 

various data 

series. If you 

include the series 

labels from your 

worksheet, Excel will 

add these to the legend. 

Otherwise the legend will simply say 

series 1, series 2, etc.

Categories are the names that are 

placed along the X-axis of a chart and 

are determined by the labels in your 

spreadsheet.

An axis is a line that labels the 

information in a chart according to the 

labels in the columns and rows of your 

spreadsheet. Axes provide a reference for 

measurement or comparison 

of the data in the chart. 

Most charts have a 

vertical axis (known 

as the Y-axis) and 

a horizontal axis 

(known as the 

X-axis).
A
xi
s

D
at

a ra
nge

Category

Legend

Producing a chart

To produce a chart, you must �rst enter data into a worksheet. 

Select the data, either by clicking and dragging over it with the mouse, or by selecting one of 
the cells, then holding down the Shi4 key and pressing the arrows on the keyboard. 

Use the Insert tab and select the appropriate chart under the Charts section. 7e type of 
chart you choose will depend on your organisational requirements. 

A chart is linked to the worksheet it is created from, so if you alter the data in the worksheet, 
the chart will be updated.  

3B Create charts
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Practice task 17

Take the following steps to produce a column chart.

1. Open Excel and enter the data below into a worksheet. Save the worksheet as ‘Company 
cars’.

2. Select cells A4–E9. 7is selection should cover all the labels and values and will become 
your data range. Do not include any blank rows or columns in your selected cell range.

3. Go to the Insert tab and select Insert column chart. 7e chart will now display as an 
object in your spreadsheet.
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4. To move the chart to a separate sheet in the workbook, go to the Design tab and select 
Move Chart. 

5. A dialog box will appear. Select the option to place the chart in a new sheet. Give it an 
appropriate name, e.g. ‘Cars by state’. Click OK.

6. 7e chart will now have a separate sheet in the workbook. If you look at the worksheet 
names, you will notice that the chart now appears there.

7. If the data you want to include in a chart is not in adjacent rows and columns, use the 
Ctrl key to make multiple selections in diDerent locations on your worksheet.

8. Add trendlines by selecting the Design tab and selecting Trendline from the Add Chart 
Element tool.
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Practice task 18

1. Create this spreadsheet data for Hemline Miller that shows sales results, customer 
numbers and quantities sold. Save the document as ‘Hemline Miller January report’

2. Create a column chart that compares the sales data (remember to only select the Store 

and Sales columns).

3. Create a scatter chart that compares customer numbers with quantity sold.

4. Create pie charts for the following (remember to include the store regions): 

a. Sales results

b. Customer numbers 

c. Quantity sold
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Once you have created a chart, you need to format it to suit organisational and 

task requirements. 

7is may include formatting the data range, text and legend, or adding a pattern to the chart 
area. Formatting the chart can also enhance the presentation and overall readability of the 
numerical data.

If you do not have a colour printer or are not presenting the charts electronically, it is not 
necessary to spend a lot of time selecting colours. You only need to ensure the font type and 
size are appropriate and that any information in the chart is clearly presented.

All parts of the chart are separate components and can be formatted and adjusted as 
needed. To select part of the chart, point and click to select it and either use the toolbar or 
right-click mouse shortcut menus to make appropriate changes. 

7ere are various options for formatting, including:

• using colours 

• adding gridlines

• adding borders

• inserting or amending titles and labels

• changing font size and type 

• changing the type of chart used.

Titles in a chart are separate objects and can be moved around and resized by clicking and 
dragging with your mouse.

Design, format and layout tools

There are various tools available to help you improve the appearance of your 

charts.

A&er you insert a chart into your worksheet, you will notice that two new tabs appear when 
you select the chart: Design and Format. Layout tools also appear next to the chart.

Design tools enable you to: 

• change the type of chart selected

• choose the style and layout

• alternate the view of data between row and column

• check and adjust the selected data.

Formatting tools enable you to alter the general appearance of the chart, such as the colour, 
font type and size.

3C Use formatting features to modify 
the chart type and layout
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7e data table is the data contained in the spreadsheet that the chart draws its 
information from. 

Layout tools enable you to adjust the appearance of the chart by adding various elements 
such as titles, labels and gridlines.
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Practice task 19

Take the following steps to format a chart.

1. Open the ‘Company cars’ chart.

2. Right-click inside any of the Adelaide columns and select Format Data Series. 

3. In the dialog box, select the Fill tab and select Gradient 5ll. Choose a preset gradient 
colour and click Close. 

You will notice that the Adelaide data now has a shade eDect in the chart. If you want to 
change the look to something diDerent, select Picture or texture 5ll instead, then select an 
appropriate texture.

4. Repeat this process to choose Gradient )lls for the Melbourne, Perth and Sydney 
columns. 

5. 7e plot area is the space behind the columns. Right-click in the plot area and select 
Format Plot Area to open the dialog box. 
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6. In the Fill tab, select Solid 5ll and choose an appropriate colour. You can also adjust the 
transparency to make the colour lighter or darker. Click Close.

7. 7e Chart area is the space behind the legend and the chart labels. Right-click in the 
Chart area and select Format Chart Area to open the dialog box. 

8. In the Fill tab, select Solid Fill and choose an appropriate colour. Click Close.
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9. To add a border to the chart area, select Solid line under the Border section, then 
change the colour to black. Click Close.

10. To add a chart title, click on the chart title box and type ‘Company cars’ in the textbox.

11. To add axis titles to the chart, select Chart Elements, then tick Axis Titles from the 
drop-down menu. In the horizontal (x-axis) textbox type ‘Make of car’ and in the 
vertical (y-axis) textbox type ‘Number of cars’.

12. To format the text in the chart title, select the Chart title and use the formatting tools 
in the Home tab. Format the title to be Arial, Bold, 16. Format the labels of the axes 
(‘Make of car’ and ‘Number of cars’) to be Arial, Bold, 12. Format the legend to be 
Arial, Bold, 10.

13. To add data labels to the chart, click on the chart and select Chart Elements, then tick 
the Data Labels options. Use the arrow to the right of this option to select an 
appropriate position in the chart (such as Inside End). 

14. Format gridlines in the chart by right-clicking on a gridline and selecting Format 
Gridlines. 7is will open a dialog box. Under Line, select a dash type. Click Close.
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7e chart should appear similar to the following.

Summary

• A chart is a graphical representation of selected spreadsheet data.

• Charts are visually appealing and make it easy to display comparisons, patterns and 
trends in data.

• 7e type of chart you choose to present data will depend on organisational and task 
requirements.

• When you insert a chart into an Excel worksheet, two new tabs appear: Design and 
Format. 7e Layout options also become available.

• Each component of a chart can be formatted and adjusted individually as needed.

• In a workbook, a chart can appear either as an object in a worksheet or in a separate 
worksheet.
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Learning checkpoint 3 
Produce simple charts

Part A
1. Explain the type of data most suited to each of these chart types:

a. Pie chart

b. Column chart

c. Stacked bar chart

d. Line chart
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Part B

Look at the following data and complete the tasks that follow.

1. Choose a chart that best suits this data. Create the chart.

2. Save the worksheet as ‘Sales )gures’ and store it in an appropriate place.

3. Format each of the data ranges with a new colour. Add a gradient, texture or pattern to 
each data series.

4. Format the title and legend to improve readability.

5. Print out your ‘Sales )gures’ chart. 
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You need to be able to produce quality spreadsheets and charts that adhere to 

organisational and task requirements. 

Make sure that the )nal spreadsheet and chart have been thoroughly checked and proofread 
before sending or presenting them so the correct message is delivered. 

For example, if you have not spellchecked a document and it contains errors, or if you use 
an old product code, this sends a negative message to the receiver of the information. 7ey 
may think that you, and the company or department, do not really care about the matter 
contained in the report. 

In this topic you will learn how to:

4A Preview, adjust and print spreadsheets and accompanying charts

4B Ensure data meets time lines and requirements for speed and accuracy

4C Name and store spreadsheets and exit applications safely
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When preparing spreadsheets and charts, it is important that you adhere to the 

required time lines and job instructions. 

If you believe alterations are needed to either the 
time line or job instructions, you should discuss this 
with your supervisor and/or the person who has 
requested the work.

Many businesses have strict deadlines for completing 
tasks; for example, your manager might need a 
)nancial report for a weekly meeting. Failing to meet 
the deadline and provide the required information 
may aDect other tasks.

Many spreadsheets need to be accessed by other 
people in your work team, so make sure you save )les 
appropriately so that spreadsheets are easier to access.

Save )les: 

• in the correct drive, e.g. the network drive 

• in the appropriate folder, e.g. your department name

• in an appropriate sub-folder, e.g. the project name 

• with an appropriate )le name that is clear and speci)c, e.g. ‘Sales-report-March-2018’.

Print a worksheet or workbook

Before printing a workbook or spreadsheet you have created, you need to make 

sure you have undertaken a number of checks.

First, make sure you have adhered to and met all organisational and task requirements for 
completing the spreadsheet. 7is incorporates instructions for information to be included, 
as well as formatting and layout of information. You should also proofread your spreadsheet 
and check all formulas and functions before printing. If needed, make appropriate 
adjustments to the data.

Many organisations follow a policy that spreadsheets are previewed and checked on screen 
prior to printing. Even if this is not the current policy in your workplace, it is good practice 
to include it in your routine work tasks.

It is also important that you do a print preview of the data prior to printing, as this can save 
time and improve e�ciency. It reduces paper wastage and allows you to undertake a check 
of the data, ensuring accuracy of information and presentation.

Be careful when selecting multiple worksheets. If you have a number of worksheets active at 
one time, any data that you alter and input will be repeated on all of the selected worksheets. 
To deactivate multiple selected worksheets, simply click on one worksheet name. 7is will 
become the active worksheet.

Scaling allows you to adjust the size of the printout and make it larger or smaller on the 
printed page.

4A Preview, adjust and print spreadsheets 
and accompanying charts
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You may be dealing with a very large worksheet or your manager may have requested 
only some information from a worksheet. If this occurs, you may need to print part of a 
worksheet.

To print a workbook comprising multiple worksheets, follow the instructions for printing a 
worksheet, but in the )rst drop-down menu under Settings select Print Entire Workbook.

Practice task 20

Take the following steps to print part of a worksheet.

1. Open the ‘Current clothing’ worksheet.

2. Select cells A4–B17. 7is should cover all the ‘Month’ and ‘Income’ data.

3. From the File tab, select Print.

4. Select the )rst drop-down menu under Settings and change to Print Selection.

5. Under Settings, select the Orientation drop-down menu and change it to Landscape 
Orientation. 

6. Select the Scaling drop-down menu, and select Custom Scaling Options. In the Page 
Setup dialog box, change the scaling to 135%. Click OK.

7. Click Print.
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Practice task 21

Take the following steps to print a chart.

1. Open the document ‘Company cars’.

2. Select the chart by clicking on it. Because this has been selected, only the chart will be 
previewed and not the data in the spreadsheet.

3. From the File tab, select Print. Your chart will be displayed exactly as it will be printed. 
Under the Margins drop-down menu, select Custom Margins. Change the settings of 
the top, bottom, le& and right margins. Click OK.

4. Select the )rst drop-down menu under Settings and change to Print Selected Chart. 
Click Print.

Practice task 22

1. Open your document ‘Company cars’ and do the following:

• Select cells A4:B9; this will select only the make of the cars and Melbourne data.

• Print only the selected data.

• Close the )le.

2. From your ‘Current clothing’ worksheet, print out the ‘Pro)t’, ‘Tax’ and ‘End pro)t’ 
columns, including the ‘Totals’. Adjust the size of your selection until it is 150 per cent of 
its normal size.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

93

Topic 4
Finalise spreadsheets

Whenever you are given a work task, you need to create a time line, which is a 

plan for how long it will take to complete the task, usually broken down into 

smaller tasks or steps. 

Time lines will normally be pre-designated and 
depend on task instructions and deadlines. 7is 
means that work you are completing needs to be 
)nished within a speci)ed time.

You may have to create a spreadsheet to your 
manager’s speci)cations. 7e spreadsheet may be 
needed for a board or client meeting; sometimes if it 
is not ready on time, it will not be useful.

Find out when the spreadsheet is required and enter 
the date in your diary. Identify and plan the task 
requirements to work out how long it is likely to 
take. Careful planning means there will be no last-
minute panic.

If you are developing a spreadsheet for someone else to use, always clarify exactly what is 
required; for example, are there graphs or formulas needed? If you have to write formulas, 
make sure you allow enough time to have them checked by your manager.

Time line checklist

Preparing a checklist can help you plan a work task. 

Creating spreadsheets will become easier once you are familiar with your organisation’s 
requirements.

Look at the following example of a checklist.

Task Deadline Requirements Completed

Create a 

spreadsheet 

for the 

manager

17 March • Enter product data.

• Proofread the data.

• Format the spreadsheet using the 

organisation’s style guide.

• Create a new column titled 

‘Discount’.

• Write a formula to calculate 10 per 

cent of customers’ balances.

• Create a column titled ‘Sale price’.

• Write a formula to calculate the new 

sale price.



4B Ensure data meets time lines and 
requirements for speed and accuracy
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Enhance speed and accuracy

When producing reports and charts in Excel, it is important that you undertake 

tasks in a timely and e<cient manner. 

Try to stick to time lines and use the so&ware appropriately and e�ciently to save time and 
ensure data is accurate. It is better to complete the task carefully and methodically rather 
than producing work that needs to be repeated due to inaccuracies.  

Use shortcut menus (right-click the mouse button) to bring up quick commands for 
undertaking actions. Use shortcut keys to undertake actions quickly (e.g. use Ctrl+X to 
cut and Ctrl+V to paste). Familiarise yourself with the tools available in the ribbons and 
the groups of tools under each tab. If you think there should be an easier way of doing 
something, there probably is. Search the Excel help facility for assistance.

Use the numeric keypad on your keyboard to enter data. Try to improve your typing speed 
and accuracy for text-based entries.

Determine and meet time lines

In a workplace, you will often be required to meet speci�c deadlines. 

In many cases, time lines are set and agreed with 
your stakeholders – both internal and external:

• Internal stakeholders are those that work at 
the same organisation as you, and may include 
colleagues in other departments, managers and 
supervisors. 

• External stakeholders are those that are outside 
the organisation, including customers and 
suppliers. 

O&en your manager or supervisor will give you a 
deadline for completing a set task (e.g. prepare a dra& 
summary report by 2pm). Alternatively, you may 
have deadlines for completing regular work tasks 
(e.g. completing a monthly report on any customers whose invoices are unpaid or overdue). 
7ere may even be )nancial requirements to complete a task by a certain date (e.g. create a 
summary report of GST costs to submit to the ATO by the end of the )nancial year). It is 
important to adhere to organisational time lines for the e�cient running of the business. 

Meeting a deadline demonstrates your competency and professionalism in undertaking 
tasks. Make sure that when deadlines are being set, they are both achievable and realistic. It 
will not reJect well on you if your work is submitted well ahead of the deadline, but contains 
mistakes and has a poor presentation. 

If you have concerns that a deadline might not be met or you have conJicting work 
priorities, discuss this with your manager or with the client as soon as possible. 7ey may 
be able to assist you by suggesting how the deadline can be met, or they may be willing to 
adjust the deadline or task requirements.

Using a diary system and a to-do list can help you prioritise tasks and be aware of the time 
lines required for set tasks.
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Practice task 23

Read the case study, then answer the questions that follow.

Case study
Charles works as a personal assistant to a manager in a large organisation. One of his tasks is to 

create spreadsheets. Charles is asked to create a spreadsheet with information about products. He 

is given a lot of information about the products, including their codes, prices and how many have 

been sold over the last �nancial year.

Charles clari�es with his manager the exact information that is needed. His manager wants to know 

how much every product costs to calculate a 10 per cent discount off all stock for a stocktake sale. 

Charles is given two days to produce the spreadsheet. 

Charles selects the information that is needed in the spreadsheet. He breaks the task into parts 

and creates a checklist for every task that needs to be done and when it should be completed by. 

He then writes a formula to calculate the new prices of the products with a 10 per cent discount 

applied. He tests his formula and shows the spreadsheet to his manager.

Question 1 

How did Charles decide what information was needed in the spreadsheet?

Question 2 

How did Charles organise his tasks so that he could manage his time effectively?

Question 3 

Imagine you are Charles. What columns of information would you place in your spreadsheet to 

produce the results your manager wants?

Question 4 

How can a checklist help you to produce a spreadsheet according to time lines?
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How information is stored and the security measures used to protect it are 

central to an organisation’s procedures.

Information is a valuable asset in any organisation. 

7e spreadsheets you create will usually be stored on 
a server that allows access by multiple users. A server 
is a computer that delivers information and so&ware 
to other computers linked by a network.

To enable staD to log onto a server, the systems 
administrator issues each user with a username. 7e 
user must then create a password. Usernames and 
passwords:

• give users access to the information they require 
to complete work tasks

• allow each user to have a diDerent level of access 
to information.

Some of the spreadsheets you work with may be con)dential. Ask your manager for your 
organisation’s policies regarding con)dential information.

Document loss

Data needs to be safeguarded against accidental or deliberate damage. 

Data loss is usually caused by human error or system failure. Many organisations use a data 
cartridge to back up the information on a database at the end of the day. 7is cartridge can 
then be taken oDsite for security. 7is means that if any damage occurs to the server or the 
premises, a complete information backup is available.

A server is made up of lots of )les and folders. Organising this information helps users )nd 
what they are looking for. If you are saving information onto a server, make sure you know 
where to put it. Find out your organisation’s policies regarding the storage and security of 
Excel )les. 

Create a spreadsheet to be used by previous versions 
of Excel

Microsoft Excel 2016 has many advanced features that are not available in 

previous versions. 

If you are creating a spreadsheet that may be accessed electronically by people with older 
versions of Excel, you will need to work in Compatibility Mode, which turns oD some of 
the newer, more advanced features and ensures that those working in older versions (e.g. 
Microso& Excel 2003) will still have full editing capabilities.

To create a spreadsheet in Compatibility Mode, go to the File tab and select Save As. Select 
Browse and under the Save as type drop-down list, select Excel 97–2003.

In the File name )eld, type an appropriate name for your spreadsheet and click Save. You 
should do this when you )rst create a spreadsheet to avoid issues down the track.

4C Name and store spreadsheets, 
and exit applications safely



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

97

Topic 4
Finalise spreadsheets

Folder structure and naming standards

When producing spreadsheets, you need to be aware of how to name them and 

where to store them.

All organisations have policies and procedures for naming and storing spreadsheets. Ask 
your manager to explain your organisation’s requirements.

Folder structure and naming standards allow staD to set up and access folders quickly and 
easily. 

Shared directories are folders on a network that a group of people have access to. If you use 
these, you need to assess whether an electronic )le should be placed in the shared directory 
or stay on your computer’s hard drive. Decide which reports are for your use and which 
need to be shared with other.

Advantages of using shared directories and naming standards:

 • They can prevent the loss or mis�ling of electronic documents.

 • Work is less likely to be duplicated.

 • It makes it easier to share information between colleagues.

 • Reports on the same or related subjects are located together, which helps people 

�nd and retrieve relevant �les.

Hard- and soft-copy storage

Files can be stored in soft or hard copy. This means that they can be stored 

electronically in a computer or in a paper-based form in a �ling cabinet.

Many organisations prefer to store information digitally. Paper reports can be easily torn, 
mis)led or accidentally disposed of, and physical storage can also be expensive. 

Digital storage, on the other hand, saves on paper and space. Another advantage of storing 
reports digitally is that powerful databases can be used to search the stored information. 
Databases enable you to )nd speci)c information that would be much harder to )nd by 
searching through hard copies of reports.

Databases also provide management with powerful metrics and reporting tools. For 
example, statistical information can be gathered from a database, enabling detailed reports 
to be produced.

It is common for spreadsheets that are stored digitally to also be stored in hard copy. 7is 
safeguards against a computer system failure. Hard-copy storage requires space and a )ling 
system that uses consistent, simple and meaningful names, similar to digital storage.

Hard-copy spreadsheets must be kept up to date. It is necessary to manage hard-copy 
spreadsheets, as storage space in organisations is o&en scarce and valuable. Old or 
superseded spreadsheets must be destroyed on a regular basis. Retention schedules list the 
time frame spreadsheets need to be kept for before they can be destroyed. Spreadsheets 
without permanent value may be scheduled for eventual destruction.

Find out what kind of storage system is used in your organisation.
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Shared directory

To set up a shared directory, you must �rst allocate a shared network drive. 

Your IT coordinator can help with this.

7e )rst place to organise a directory is at the folder level. Folders have a tree-like structure 
that branches from a parent directory to sub-folders in a hierarchical structure.

7e following example shows the structure of a shared directory.

SERVER (C drive)

Group A

Group B

Group C

Procedures

Personnel

Projects

Project A

Project B

Project C

Project C_timelines.xlsx

Project C_reserach.xlsx

In this structure, the server has three folders for three separate work groups: 

• Group A

• Group B 

• Group C

Group C has three major folders: 

• Procedures

• Personnel 

• Projects 

7e Projects folder includes: 

• Project A

• Project B 

• Project C
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Project C has two spreadsheets: 

• ProjectC_time lines.xlsx 

• ProjectC_research1.xlsx

7e )le path for retrieving a )le starts at the server and ends when the correct )le is located. 
For example, to reach ProjectC_time lines.xlsx, the )le path to follow is  
C:\Group C\Projects\Project C\ProjectC_time lines.xlsx.

In Microso& Excel 2016, the spreadsheet extension is .xlsx.

Document properties

It can be useful to use document properties to record common information 

about a �le.

Document properties assist in describing or identifying a )le, and include details such as the 
title, author name, subject and keywords about the topic of the spreadsheet. 7e information 
contained in document properties can also be used when conducting a search for )les on 
your computer.

To set document properties, select the File tab and ensure the Info tab is selected. Titles, 
tags and categories can be added under the Properties section. Any additional authors of the 
document can also be added under the Related People section.

Back up 1les

Many organisations have set procedures for backing up �les.

In many large organisations, this is administered through the IT department and is an 
automatic process. In this case, you simply need to ensure you have saved your )les to the 
appropriate network drives and folders.

Backing up )les is an important protocol. It helps to prevent the loss of documents 
and information, and is extremely useful when something happens to the network or 
computer system.

In smaller organisations, you may need to back up )les yourself – this may be done on 
a daily or weekly basis. Check with your supervisor for back-up procedures, such as 
requirements to back up )les to another disk drive. 

7e organisation should regularly delete old electronic )les and folders to ensure an e�cient 
use of server space. Always ask for authorisation before making any deletions.

USB memory sticks are also useful for storing and backing up information, especially when 
you require a portable copy of the information.



100
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU212
Create and use spreadsheets

Prevent data loss

After creating or modifying an electronic spreadsheet, you need to exit the 

software application without causing data loss or damage. 

Data loss occurs when a computer program stops performing its expected function. O&en 
the program or even the whole computer may appear to freeze.

All computer users will experience data loss at some time and will be unable to access 
their data because it has been accidentally erased or corrupted. 7e main cause of data 
loss is human error. Other causes of data loss include virus damage, operating system or 
application so&ware bugs, and failed upgrades.

Precautions to take to prevent data loss:

 • Try to work on only one spreadsheet at a time.

 • If you need to work with multiple applications open, close applications that are no 

longer needed. This will help your computer work more quickly and will prevent data 

loss in the event of computer failure.

 • Lock your computer or exit the application before leaving your workstation 

unattended to prevent someone else from tampering with your work.

 • If your computer starts to make unusual noises, shut it down immediately and do not 

turn it back on until you have received advice from an IT coordinator. 

To exit the program safely (without losing data), save your work and select the exit button, 
which is located in the top right corner of the window. If you make any changes a&er saving 
your work, you will be prompted to save these changes before exiting.

Practice task 24

Read the )rst case study, then answer the questions that follow.

Case study 1
Matthew works as an of�ce administrator in a large organisation. His duties include formatting 

reports and saving them on the server. He is also responsible for backing up the server at the end of 

each day. 

At the end of a busy day, Matthew had completed several reports for different departments in the 

organisation. He had to save each of them in a different location, and it took him a while to work out 

where they all belonged. He wasn’t sure if he had saved them all in the correct place. After this, he 

was running late and decided not to back up the server. 

The next morning, the reports that Matthew had saved were needed for an important board meeting. 

However, during the night a virus had infected the server, destroying all the information from the 

previous day.
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Question 1 

What would be the consequences if Matthew did not save some of the reports in the correct 

place?

Question 2 

What are two potential consequences of not backing up data on the server?

Read the second case study, then answer the questions that follow.

Case study 2
Fred has retired from an organisation after working as an administrative assistant for 10 years. 

The areas Fred was responsible for were accounts and projects. The day after he retired, someone 

needed a �le that Fred had created and stored. The �le contained vital accounting information. It 

was discovered that Fred had saved more than 500 �les in a variety of folders and the �le could not 

be located. The folders had ambiguous names such as Folder1 and Folder2, and the �les had names 

such as august1.doc and march2.doc.

Question 3 

Describe why Fred’s folder and �le naming system failed.

Question 4 

Fred was responsible for two areas. What could he have done to make sure �les could be easily 

located?

Question 5 

Explain why folder and �le names should be consistent, simple and meaningful.
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Summary

• Producing a spreadsheet means creating it and having it ready for viewing by your 
colleagues or manager.

• Working within a designated time line helps you to plan your work in order to meet 
deadlines.

• Make sure you have checked all formulas and functions, proofread and formatted your 
spreadsheet before printing it.

• You can either print a whole workbook, a whole worksheet or part of a worksheet, 
depending on what is required.

• A chart can be printed on its own or as part of a worksheet.

• You need to understand your organisation’s policies and procedures about saving and 
storing spreadsheets.
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Learning checkpoint 4 
Finalise spreadsheets

Part A
Read the case study, then complete the tasks that follow. 

Case study
Mario works as a personal assistant for a manager in a large organisation. His manager asks him 

to produce a spreadsheet of customer information. The spreadsheet must list all the customers 

and their accounts. It must also calculate a 10 per cent interest charge on the accounts and display 

customers’ new balances. The spreadsheet needs to be ready in two days. The following table lists 

the balances of �ve customers that Mario has to enter into the spreadsheet.

Customer information

Customers Balances

Sanchez $2,300.00

McGregor $4,000.00

Cunningham $5,000.00

Wijerwadene $4,500.00

Taylor $2,500.00

1. Prepare a checklist of all the tasks Mario will need to do to make sure the worksheet is 
completed on time. 
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2. Produce a worksheet with the details outlined on the previous page, then complete the 
following tasks: 

• Calculate the 10 per cent interest charge and the customers’ new balances.

• Check the data you entered against the customer information you have been given 
and correct any errors.

• Create a bar chart that displays the customers’ original balances and new balances.

• Name and store your worksheet in a suitable location.

• Preview the chart before printing and make adjustments to include a chart title. 
Print the chart out as a separate page. 

Part B
1. Look at the table below. In a worksheet, enter the data exactly as it is in the example.

2. Use a function to calculate the monthly totals and apply this to the ‘Totals’ row.

3. Use a function to work out the ‘Overall total’ and apply this to cell B12.

4. Check that all data and calculations you entered are correct. Remember to proofread the 
spelling of names.

5. Name the worksheet ‘Sales results’ and store it in an appropriate place.

6. Print out your worksheet.
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